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Trademarks and Copyright 

Trademarks 

Windows is a registered trademark of the Microsoft Corporation in the United States and other countries. 
All other brand and product names are trademarks or registered trademarks of their respective owners. 
Protected trademarks are not marked as such in this manual. This does not mean, however, that they may be used freely. 

Copyright information 

Code provided by third party providers was used for Avira Free Antivirus. We thank the copyright owners for making the code available 
to us. 
For detailed information on copyright, please refer to "Third Party Licenses" in the program help of Avira Free Antivirus. 

End User License Agreement - EULA 

https://www.avira.com/en/license-agreement 

Privacy Policy 

https://www.avira.com/en/general-privacy 

https://www.avira.com/en/license-agreement
https://www.avira.com/en/general-privacy
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1. Introduction 

Your Avira product protects your computer against viruses, worms, Trojans, adware and 
spyware and other risks. In this manual these are referred to as viruses or malware 

(harmful software) and unwanted programs. 

The manual describes the program installation and operation. 

For further options and information, please visit our website: 
http://www.avira.com 

The Avira website lets you: 

 access information on other Avira desktop programs 

 download the latest Avira desktop programs 

 download the latest product manuals in PDF format 

 download free support and repair tools 

 access our comprehensive knowledge database and FAQs for troubleshooting 

 access country-specific support addresses. 

Your Avira Team 

1.1 Icons and emphases 

The following icons are used: 

Icon / 

designation 

Explanation 

 

Placed before a condition which must be fulfilled prior to 
execution of an action. 

 

Placed before an action step that you perform. 

Warning Placed before a warning when critical data loss might occur. 

Note Placed before a link to particularly important information or a tip 
which makes your Avira Free Antivirus easier to use. 

The following emphases are used:   

http://www.avira.com/
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Emphasis Explanation 

Italics File name or path data. 

Displayed software interface elements (e.g. window section or 
error message). 

Bold Clickable software interface elements (e.g. menu item, 
navigation area, option box or button). 
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2. Product information 

This chapter contains all information relevant to the purchase and use of your Avira 

product: 

 see Chapter: Delivery scope 

 see Chapter: System requirements 

 see Chapter: Licensing and Upgrade 

Avira products are comprehensive and flexible tools you can rely on to protect your 
computer from viruses, malware, unwanted programs and other dangers. 

  Please note the following information: 

Warning 
Loss of valuable data usually has dramatic consequences. Even the best virus 
protection program cannot provide one hundred percent protection from data 
loss. Make regular copies (Backups) of your data for security purposes. 

  

Note 
A program can only provide reliable and effective protection from viruses, 
malware, unwanted programs and other dangers if it is up-to-date. Make sure 
your Avira product is up-to-date with automatic updates. Configure the program 
accordingly. 

2.1 Delivery scope 

Your Avira product has the following functions: 

 Control Center for monitoring, managing and controlling the entire program 

 Central configuration with user-friendly standard and advanced options and context-
sensitive help 

 System Scanner (on-demand scan) with profile-controlled and configurable scan for all 
known types of virus and malware 

 Integration into the Windows User Account Control allows you to carry out tasks 
requiring administrator rights. 

 Real-Time Protection (on-access scan) for continuous monitoring of all file access 
attempts 

 Avira SearchFree Toolbar, a search toolbar integrated in the web browser providing 
quick and convenient search options. It also includes widgets of the most common 
Internet functions.  
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 Web Protection (for Avira Free Antivirus users, only in combination with Avira 
SearchFree) for monitoring data and files transferred from the Internet using the HTTP 
protocol (monitoring of ports 80, 8080, 3128) 

 Avira Social Network Protection, a monitoring tool, informs parents of their children's 
online activities. It checks their social network accounts for comments, photos etc. that 
may influence the child's reputation in a negative way or may indicate that the child is in 
danger.  

 Avira Android Security app is not only focused on anti-theft measures. The app helps 
you to get back your mobile device once you have misplaced it, or even worse: if it has 
been stolen. Furthermore the app allows you to block incoming calls or SMS. Avira 
Android Security protects cell phones and smartphones running with the Android 
operating system. 

 Integrated quarantine management to isolate and process suspicious files 

 Rootkits protection for detecting hidden malware installed in your computer system 
(rootkits) 
(Not available under Windows XP 64 bit) 

 Direct access to detailed information on the detected viruses and malware via the 
Internet 

 Simple and quick updates to the program, virus definitions, and search engine through 
Single File Update and incremental VDF updates via a web server on the Internet  

 Integrated Scheduler for planning one-off or recurring jobs such as updates or scans 

 Extremely high virus and malware detection via innovative scanning technology (scan 
engine) including heuristic scanning method 

 Detection of all conventional archive types including detection of nested archives and 
smart extension detection 

 High-performance multithreading function (simultaneous high-speed scanning of 
multiple files) 

2.2 System requirements 

2.2.1 System requirements Avira Free Antivirus 

Avira Free Antivirus has the following requirements for successful use of the system: 

Operating system 

 Windows 8, newest SP (32 or 64 bit) or 

 Windows 7, newest SP (32 or 64 bit) or 

 Windows XP, newest SP (32 or 64 bit) 

Hardware 

 Computer with Pentium processor or later, at least 1 GHz 
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 At least 150 MB of free hard disk memory space (more if using quarantine for temporary 
storage) 

 At least 1024 MB RAM under Windows 8, Windows 7 

 At least 512 MB RAM under Windows XP 

Other requirements 

 For the program installation: Administrator rights 

 For all installations: Windows Internet Explorer 6.0 or higher 

 Internet connection where appropriate (see Preparing for installation) 

2.2.2 System requirements Avira SearchFree Toolbar 

The following requirements have to be met for a proper use of the Avira SearchFree 

Toolbar: 

Operating system 

 Windows 8, newest SP (32 or 64 bit) or 

 Windows 7, newest SP (32 or 64 bit) or 

 Windows XP, newest SP (32 or 64 bit) 

Web browser 

 Windows Internet Explorer 6.0 or higher 

 Mozilla Firefox 3.0 or higher 

 Google Chrome 18.0 or higher 

Note 
If necessary, please uninstall any previously installed search toolbars before 
you install the Avira SearchFree Toolbar. Otherwise you will not be able to 

install the Avira SearchFree Toolbar. 

2.2.3 Administrator rights (since Windows Vista) 

On Windows XP, many users work with administrator rights. However, this is not desirable 
from the point of view of security because it is then easy for viruses and unwanted 
programs to infiltrate computers. 

For this reason, Microsoft introduced the "User Account Control" (UAC). The User Account 
Control is part of the following operating systems: 

 Windows Vista 

 Windows 7 

 Windows 8 
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The User Account Control offers more protection for users who are logged in as 
administrators. Thus an administrator only has the privileges of a normal user at first. 
Actions for which administrator rights are required are clearly marked by the operating 
system with an information icon. In addition, the user must explicitly confirm the required 
action. Privileges will only then be increased and the administrative task will be performed 

by the operating system after this permission has been obtained. 

The Avira Free Antivirus requires administrator rights for some actions. These actions are 

marked with the following symbol: . If this symbol also appears on a button, 
administrator rights are required to carry out this action. If your current user account does 
not have administrator rights, the Windows dialog of the User Account Control asks you to 
enter the administrator password. If you do not have an administrator password, you 
cannot carry out this action. 

2.3 Licensing and Upgrade 

In order to be able to use your Avira product, you require a license. You thereby accept the 

license terms. 

The license is issued via a digital license in the form of a .KEY file. This digital license file 
is the key to your personal license. It contains exact details of which programs are licensed 
to you and for what period of time. A digital license file can therefore also contain the 
license for more than one product. 

If you purchased your Avira product on the Internet, or via a program CD/DVD, the digital 
license file is sent to you by email.  

A valid activation code is already contained in Avira Free Antivirus. For this reason, 
product activation is not required. 
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3. Installation and uninstallation 

This chapter contains information relating to the installation of Avira Free Antivirus. 

 Preparing for installation 

 Installing downloaded software 

 Removing incompatible software 

 Choosing an installation type 

 Installing Avira Free Antivirus 

 Changing the installation 

 Uninstalling Avira Free Antivirus 

3.1 Preparing for installation 

  Before installation, check whether your computer fulfills all the minimum System 
Requirements. 

  Close all running applications. 
  Make sure that no other virus protection solutions are installed. The automatic 

protection functions of various security solutions may interfere with each other (for 
the automatic options see Removing incompatible software). 

  If necessary, please uninstall any previously installed search toolbars before you 
install the Avira SearchFree Toolbar. Otherwise you will not be able to install the 
Avira SearchFree Toolbar. 

  Establish an Internet connection. 

 The connection is necessary for performing the following installation steps: 

 Downloading the current program file and scan engine as well as the latest virus 
definition files via the installation program (for Internet-based installation) 

 Activating the program 

 Registering as a user 

 Where appropriate, carrying out an update after completed installation 

  Keep the activation code or license file for your Avira Free Antivirus handy for the 
time when you want to activate the program. 

  For product activation or registration, your Avira Free Antivirus uses the HTTP 
protocol and Port 80 (web communication), as well as encryption protocol SSL and 
port 443, to communicate with the Avira servers. If you are using a firewall, please 
ensure that the required connections and/or incoming or outgoing data are not 
blocked by the firewall. 

3.2 Installing software downloaded from the Avira website 

  Go to www.avira.com/download. 

http://www.avira.com/download
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 Select the product and click Download. 

 Save the downloaded file on your system. 

 Double-click the installation file avira_free_antivirus_en.exe. 

 If the User Account Control window appears, click Yes. 

 The program scans for incompatible software (more information here: Removing 
incompatible software). 

 The installation file is extracted. The installation routine is started. 

 Continue with Selecting an installation type. 

Note 

You can cancel the installation and resume it later, if needed. A shortcut will be 
created on your desktop. To resume the installation you just have to double-
click the Resume installation shortcut with the Avira logo on it. 

3.3 Removing incompatible software 

The Avira Free Antivirus will search for any possible incompatible software on your 
computer. If potentially incompatible software is detected Avira Free Antivirus generates a 
list of these programs. It is recommended to remove these software programs in order not 
to endanger the stability of your computer. 

  Select from the list the check boxes of all those programs that should be removed 
automatically from your computer and click Next. 

 For some products the uninstallation has to be confirmed manually.  

 Select those programs and click Next. 

 The uninstallation of one or more of the selected programs may require a restart of 
your computer. After rebooting the installation will begin. 

3.4 Choosing an installation type 

During installation you can select a setup type in the installation wizard. The installation 
wizard is designed to smoothly guide you through the installation. 
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Related Topics: 

 see Performing an Express Installation 

 see Performing a Custom Installation 

3.4.1 Performing an Express Installation 

The Express installation is the recommended setup routine.  

 It installs all the standard components of Avira Free Antivirus. The Avira recommended 
security level settings are used. 

 As default one of the following installation paths is chosen:  

 C:\Program Files\Avira (for Windows 32bit versions) or 

 C:\Program Files (x86)\Avira (for Windows 64bit versions) 

 Here you can find all files related to Avira Free Antivirus. 

 If you choose this installation type, you can perform an installation by simply clicking 
Next until completion. 

 This installation type is designed especially for those users who do not feel comfortable 
with configuring software tools. 
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3.4.2 Performing a Custom Installation 

The Custom installation enables you to configure your installation. This is only 

recommended for advanced users who are well acquainted with matters of hard- and 
software as well as security issues. 

 You can choose to install individual program components. 

 A target folder can be selected for the program files to be installed. 

 You can disable Create a desktop icon and program group in the Start menu. 

 Using the configuration wizard, you can define custom settings for your Avira Free 
Antivirus. Also you can choose the security level that you feel comfortable with. 

 After installation you can initiate a short system scan that is performed automatically 
after installation. 

3.5 Installing Avira Free Antivirus 

 

 Confirm that you accept the End User License Agreement. For reading the 
detailed text of the End User License Agreement, click the link. 

3.5.1 Choosing a destination folder 

The custom installation allows you to choose the folder where you want to install Avira 

Free Antivirus. 
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  Click Browse and navigate to the location where you want to install Avira Free 
Antivirus. 

 Select the folder where you want to install Avira Free Antivirus in the Choose 
Destination Folder window. 

 Click Next. 

3.5.2 Installing Avira SearchFree Toolbar 

At the end of the setup you can install the Avira SearchFree Toolbar. 

Avira SearchFree Toolbar includes two main components: Avira SearchFree and the 
Toolbar. 

With Avira SearchFree you can search the Internet for any number of terms. This search 
engine displays all hits in the browser windows rating their level of safety. This allows Avira 

users a safer Internet navigation. 

The Toolbar offers you three widgets to the most important Internet-related functions. With 
one click you have direct access to Facebook and your email, or you can ensure safe web 
browsing (Firefox and Internet Explorer only). 
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 If you do not wish to install the Avira SearchFree Toolbar unmark the checkboxes of the 
options Set and keep Ask as my default search provider and Set and keep Avira 
SearchFree (avira.search.ask.com) as my browser homepage and the browser 
new tabs page. 

 If you decline, only the Avira SearchFree Toolbar setup is aborted. The installation 
of Avira Free Antivirus, however will be completed. 

3.5.3 Choosing installation components 

In a custom installation or a change installation, the following installation components can 

be selected, added or removed. 
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Select or deselect components from the list in the Install components dialog. 

 Avira Free Antivirus 
This contains all components required for successful installation of Avira Free Antivirus. 

 Real-Time Protection 
The Avira Real-Time Protection runs in the background. It monitors and repairs, if 
possible, files during operations such as open, write and copy in "on-access mode". 
On access mode means that, whenever a user carries out a file operation (e.g. load 
document, execute, copy), Avira Free Antivirus automatically scans the file. 
Renaming a file, however, does not trigger a scan by Avira Real-Time Protection. 

 Windows Firewall (starting from Windows Vista) 
This component manages the Windows Firewall from Avira Free Antivirus. 

 Rootkits Protection 
Avira Rootkits Protection checks whether software is already installed on your 
computer that can no longer be detected with conventional methods of malware 
protection after penetrating the computer system. 

 ProActiv The ProActiv component monitors application actions and alerts users to 
suspicious application behavior. This behavior-based recognition enables you to 
protect yourself against unknown malware. The ProActiv component is integrated 
into Avira Real-Time Protection. 

 Web Protection (for Avira Free Antivirus users, only in combination with the Avira 
SearchFree Toolbar) 
When surfing the Internet, you are using your web browser to request data from a 
web server. The data transferred from the web server (HTML files, script and image 
files, Flash files, video and music streams, etc.) will normally be moved directly into 
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the browser cache for display in the web browser, meaning that an on-access scan 
as performed by Avira Real-Time Protection is not possible. This could allow viruses 
and unwanted programs to access your computer system. Web Protection is what is 
known as an HTTP proxy which monitors the ports used for data transfer (80, 8080, 
3128) and scans the transferred data for viruses and unwanted programs. 
Depending on the configuration, the program may process the affected files 
automatically or prompt the user for a specific action. 

 Shell Extension 
The Shell Extension generates an entry Scan selected files with Avira in the 
context menu of the Windows Explorer (right-hand mouse button). With this entry you 
can directly scan files or directories. 

Related Topics: 

Changing an installation 

  

3.5.4 Creating shortcuts for Avira Free Antivirus 

A desktop icon and/or a program group in the Start menu help you to access Avira Free 

Antivirus more quickly and easily. 

 

  To create a desktop shortcut for Avira Free Antivirus and/or a program group in the 
Start menu leave the option(s) activated. 
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3.5.5 Configuring the heuristic detection level (AHeAD) 

Avira Free Antivirus contains a very powerful tool in form of Avira AHeAD (Advanced 
Heuristic Analysis and Detection ) technology. This technology uses pattern recognition 
techniques, so it can detect unknown (new) malware from having analyzed other malware 

previously. 

 

  Select a detection level in the Configure AHeAD dialog box and click Next. 

 The detection level selected is used for the System Scanner (On-demand scan) and 
Real-Time Protection (On-access scan) AHeAD technology settings. 

3.5.6 Selecting extended threat categories 

Virus and malware are not the only threats that pose a danger to your computer system. 
We have defined a whole list of risks and sorted those into extended threat categories for 

you. 



 Installation and uninstallation 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 24 

 

  A number of threat categories is already pre-selected by default. 

 Where appropriate, activate further threat categories in the dialog box Select 
extended threat categories. 

 If you change your mind, you can revert to the recommended values by clicking the 
Default values button. 

 Continue the installation by clicking Next. 

3.5.7 Starting a scan after installation 

To check the current security state of the computer, a quick system scan can be 
performed after the configuration has been completed and before the computer is 
rebooted. The System Scanner scans running programs and the most important system 

files for viruses and malware. 
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  If you want to perform a quick system scan, leave the Quick system scan option 
activated. 

 Click Next. 

 Complete the configuration by clicking Finish. 

 If you have not deactivated the Quick system scan option, the System Scanner 
performs a quick system scan. 

3.6 Changing the installation 

If you wish to add or remove modules of the current installation, you can do this without 

having to uninstall Avira Free Antivirus. Here is how: 

 Changing an installation under Windows 8 

 Changing an installation under Windows 7 

 Changing an installation under Windows XP 

3.6.1 Changing an installation under Windows 8 

You have the option of adding or removing individual program components of the Avira 
Free Antivirus installation (see Choosing installation components). 
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If you wish to add or remove modules of the current installation, you can use the option 
Uninstall Programs in the Windows control panel to Change/Uninstall programs. 

  Right-click on the screen. 

 The All apps symbol appears. 

 Click on the symbol and look in the Apps - Windows System section for Control 
Panel. 

 Double-click the Control Panel symbol. 

 Click Programs - Uninstall a program. 

 Click Programs and Features - Uninstall a program. 

 Select Avira Free Antivirus and click Change. 

 In the Welcome dialog of the program, select the option Modify. You will be guided 
through the installation changes. 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

Related Topics: 
Choosing installation components 

  

3.6.2 Changing an installation under Windows 7 

You have the option of adding or removing individual program components of the Avira 
Free Antivirus installation (see Choosing installation components). 
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If you wish to add or remove modules of the current installation, you can use the option 
Add or Remove Programs in the Windows control panel to Change/Remove 

programs. 

  Open the Control Panel via the Windows Start menu. 

 Double click on Programs and Features. 

 Select Avira Free Antivirus and click Change. 

 In the Welcome dialog of the program, select the option Modify. You will be guided 
through the installation changes. 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

Related Topics: 
Choosing installation components 

  

3.6.3 Changing an installation under Windows XP 

You have the option of adding or removing individual program components of the Avira 

Free Antivirus installation (see Choosing installation modules). 

If you wish to add or remove modules of the current installation, you can use the option 
Add or Remove Programs in the Windows control panel to Change/Remove 
programs. 

  Open the Control Panel via the Windows Start > Settings menu. 

 Double click on Add or Remove Programs. 

 Select Avira Free Antivirus and click Change. 

 In the Welcome dialog of the program, select the option Modify. You will be guided 
through the installation changes. 
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Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

Related Topics: 
Choosing installation components 

3.7 Uninstalling Avira Free Antivirus 

Should you ever feel the need to uninstall Avira Free Antivirus, here is how: 

 Uninstalling Avira Free Antivirus under Windows 8 

 Uninstalling Avira Free Antivirus under Windows 7 

 Uninstalling Avira Free Antivirus under Windows XP 

3.7.1 Uninstalling Avira Free Antivirus under Windows 8 

To uninstall Avira Free Antivirus from your computer use the option Programs and 

Features in the Windows Control Panel. 

 

  Right-click on the screen. 

 The All apps symbol appears. 

 Click on the symbol and look in the Apps - Windows System section for Control 
Panel. 

 Double-click the Control Panel symbol. 

 Click on Programs - Uninstall a program. 

 Click on Programs and Features - Uninstall a program. 

 Select Avira Free Antivirus in the list and click Uninstall. 

 When asked if you really want to remove the application and all its components, 
click Yes to confirm. 

 All components of the program will be removed. 

 Click Finish to complete uninstallation. 
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 If a dialog box appears recommending that your computer be restarted, click Yes to 
confirm. 

 Avira Free Antivirus is now uninstalled and all directories, files and registry entries 
for the program are deleted when your computer is restarted. 

Note 
The Avira SearchFree Toolbar is not included in the uninstallation program and 

must be uninstalled separately. 

  

Note 

If you uninstall the Avira SearchFree Toolbar, Web Protection is also 
uninstalled. 

3.7.2 Uninstalling Avira Free Antivirus under Windows 7 

To uninstall Avira Free Antivirus from your computer use the option Programs and 

Features in the Windows Control Panel. 

 

  Open the Control Panel via the Windows Start menu. 

 Click Programs and Features. 

 Select Avira Free Antivirus in the list and click Uninstall. 

 When asked if you really want to remove the application and all its components, 
click Yes to confirm. 

 All components of the program will be removed. 

 Click Finish to complete uninstallation. 

 If a dialog box appears recommending that your computer be restarted, click Yes to 
confirm. 

 Avira Free Antivirus is now uninstalled and all directories, files and registry entries 
for the program are deleted when your computer is restarted. 
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Note 
The Avira SearchFree Toolbar is not included in the uninstallation program and 

must be uninstalled separately. 

  

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 
uninstalled. 

3.7.3 Uninstalling Avira Free Antivirus under Windows XP 

To uninstall Avira Free Antivirus from your computer use the option Change or Remove 

Programs in the Windows Control Panel. 

  Open the Control Panel via the Windows Start > Settings menu. 

 Double click on Add or Remove Programs. 

 Select Avira Free Antivirus in the list and click Remove. 

 When asked if you really want to remove the application and all its components, 
click Yes to confirm. 

 All components of the program will be removed. 

 Click Finish to complete uninstallation. 

 If a dialog box appears recommending that your computer be restarted, click Yes to 
confirm. 

 Avira Free Antivirus is now uninstalled and all directories, files and registry entries 
for the program are deleted when your computer is restarted. 

Note 
The Avira SearchFree Toolbar is not included in the uninstallation program and 

must be uninstalled separately. 

  

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

3.7.4 Uninstalling Avira SearchFree Toolbar 

Uninstalling Avira SearchFree Toolbar 

Should you ever feel the need to uninstall Avira SearchFree Toolbar, here is how: 
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 Uninstalling Avira SearchFree Toolbar under Windows 8 

 Uninstalling Avira SearchFree Toolbar under Windows 7 

 Uninstalling Avira SearchFree Toolbar under Windows XP 

 Uninstalling Avira SearchFree Toolbar via the web browser 

 Uninstalling Avira SearchFree Toolbar via Add-On Manager 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 

uninstalled. 

Uninstalling Avira SearchFree Toolbar under Windows 8 

To uninstall your Avira SearchFree Toolbar: 

  Close the web browser. 

 Right-click in one of the bottom corners of the screen. 

 The All apps symbol appears. 

 Click on the symbol and look in the Apps - Windows System section for Control 
Panel. 

 Double-click the Control Panel symbol. 

 Click Programs - Uninstall a program. 

 Click  Programs and Features - Uninstall a program. 

 Select Avira SearchFree Toolbar plus Web Protection in the list and click Uninstall. 

 You will be asked if you really want to uninstall this product. 

 Click Yes to confirm. 

 Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, files 
and registry entries for the Avira SearchFree Toolbar plus Web Protection are 
deleted when your computer is restarted. 

Uninstalling Avira SearchFree Toolbar under Windows 7 

To uninstall your Avira SearchFree Toolbar: 

  Close your web browser. 

 Open the Control Panel via the Windows Start menu. 

 Double click on Programs and Features. 

 Select Avira SearchFree Toolbar plus Web Protection in the list and click Uninstall. 

 You will be asked if you really want to uninstall this product. 

 Click Yes to confirm. 
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 Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, files 
and registry entries for the Avira SearchFree Toolbar plus Web Protection are 
deleted when your computer is restarted. 

Uninstalling Avira SearchFree Toolbar under Windows XP 

To uninstall your Avira SearchFree Toolbar: 

  Close your web browser. 

 Open the Control Panel via the Windows Start > Settings menu. 

 Double click on Add or Remove Programs. 

 Select Avira SearchFree Toolbar plus Web Protection in the list and click Remove. 

 You will be asked if you really want to uninstall this product. 

 Click Yes to confirm. 

 Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, files 
and registry entries for the Avira SearchFree Toolbar plus Web Protection are 
deleted when your computer is restarted. 

Uninstalling Avira SearchFree Toolbar via the web browser 

You also have the option of uninstalling the Avira SearchFree Toolbar directly in the 

browser. This option is only available for Firefox and Internet Explorer: 

  Open your web browser. 

 In the search toolbar open the Options menu. 

 Click Uninstall toobar from browser. 

 When you are asked  if you want to uninstall the product, click Yes to confirm. 

 You will now be asked to close your web browser. 

 Close the web browser and click Retry. 

 Avira SearchFree Toolbar plus Web Protection is uninstalled and all directories, files 
and registry entries for the Avira SearchFree Toolbar plus Web Protection are 
deleted when your computer is restarted. 

Note 
To uninstall the Avira SearchFree Toolbar, the toolbar must be enabled in the 
Add-On Manager. 

Uninstalling Avira SearchFree Toolbar via Add-On Manager 

Because the toolbar is installed as an add-on, it can also be uninstalled as one: 
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Firefox 

  Click Tools > Add-ons > Extensions. From there you can manage the Avira Add-
on: activate or deactivate the toolbar and uninstall. 

Internet Explorer 

  Go to Manage Add-ons > Toolbars und Extensions. Here you can either activate 
and deactivate your Avira SearchFree Toolbar, or uninstall it. 

Google Chrome 

  Click Options > Extensions and manage easily your toolbar: activate, deactivate or 
uninstall it. 
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4. Overview of Avira Free Antivirus 

This chapter contains an overview of the functionality and operation of your Avira product. 

 see Chapter User interface and operation 

 see Chapter Avira SearchFree Toolbar 

 see Chapter How to...? 

4.1 User interface and operation 

You operate your Avira product via three program interface elements: 

 Control Center: monitoring and controlling the Avira product 

 Configuration: Configuring the Avira product 

 Tray Icon in the system tray of the taskbar: Opening the Control Center and other 
functions 

4.1.1 Control Center 

The Control Center is designed to monitor the protection status of your computer systems 

and control and operate the protection components and functions of your Avira product. 
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The Control Center window is divided into three areas: The Menu bar, the Navigation 
area and the detail window Status: 

 Menu bar: In the Control Center menu bar, you can access general program functions 
and information on the program. 

 Navigation area: In the navigation area, you can easily swap between the individual 
sections of the Control Center. The individual sections contain information and functions 
of the program components and are arranged in the navigation bar according to activity. 
Example: Activity PC PROTECTION - Section Real-Time Protection. 

 Status: The Control Center opens with the Status view, where you can see at a glance, 
if your computer is safe, and you have an overview of the active modulesand the date of 

the last system scan. The Status view also contains buttons for starting features or 
actions, such as starting or stopping the Real-Time Protection. 

Starting and closing of Control Center 

To start the Control Center the following options are available: 

 Double-click the program icon on your desktop 

 Via the program entry in the Start > Programs menu. 

 Via the Tray Icon of your Avira product. 
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Close the Control Center via the menu command Close in the menu File or by clicking on 
the close tab in the Control Center. 

Operate Control Center 

To navigate in the Control Center 

  Select an activity in the navigation bar. 

  The activity opens and other sections appear. The first section of the activity is 
selected and displayed in the view. 

  If necessary, click another section to display this in the detail window. 

Note 
You can activate the keyboard navigation in the menu bar with the help of the 
[Alt] key. If navigation is activated, you can move within the menu with the 
arrow keys. With the Return key you activate the active menu item. 
To open or close menus in the Control Center, or to navigate within the menus, 
you can also use the following key combinations: [Alt] + underlined letter in the 
menu or menu command. Hold down the [Alt] key if you want to access a 

menu, a menu command or a submenu. 

To process data or objects displayed in the detail window: 

  Highlight the data or object you wish to edit. 

 To highlight multiple elements (elements in columns), hold down the control key or 
the shift key while selecting the elements. 

  Click the appropriate button in the upper bar of the detail window to edit the object. 

Control Center overview 

 Status: Clicking on the Status bar gives you an overview of the product's functionality 
and performance (see Status). 

 The Status section lets you see at a glance which modules are active and provides 
information on the last update performed.  

 PC PROTECTION: In this section you will find the components for checking the files on 
your computer system for viruses and malware. 

 The System Scanner section enables you to easily configure and start an on-demand 
scan. Predefined profiles enable a scan with already adapted default options. In the 
same way it is possible to adapt the scan for viruses and unwanted programs to your 
personal requirements with the help of manual selection (will be saved). 

 The Real-Time Protection section displays information on scanned files, as well as 
other statistical data, which can be reset at any time, and enables access to the 
report file. More detailed information on the last virus or unwanted program detected 
can be obtained practically "at the push of a button". 
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 INTERNET PROTECTION: In this section you will find the components to protect your 
computer system against viruses and malware from the Internet, and against 
unauthorized network access. 

 The FireWall section enables you to configure the basic settings for the FireWall. In 
addition, the current data transfer rate and all active applications using a network 
connection are displayed. 

 The Web Protection section displays information on scanned URLs and detected 
viruses, as well as other statistical data, which can be reset at any time and enables 
access to the report file. More detailed information on the last virus or unwanted 
program detected can be obtained practically "at the push of a button". 

 CHILD PROTECTION: In this section you will find the components to ensure a safe 
Internet experience for your children. 

 Social Networks: This section redirects you to the Social Network Protection 
application. Social Network Protection informs parents of their children's activities 
online. It checks their social network accounts for comments, photos etc. that may 
influence the child's reputation in a negative way or may indicate that the child is in 
danger. 

 MOBILE PROTECTION: From this section you will be redirected to the online access 
for Android devices. 

 Avira Android Security manages all your android-based devices. 

 ADMINISTRATION: In this section you will find tools for isolating and managing 
suspicious or infected files, and for planning recurring tasks. 

 The Quarantine section contains the so-called quarantine manager. This is the 
central point for files already placed in quarantine or for suspect files that you would 
like to place in quarantine. It is also possible to send a selected file to the Avira 
Malware Research Center by email. 

 The Scheduler section enables you to configure scheduled scanning and update jobs 
as well as backup jobs and to adapt or delete existing jobs. 

 The Reports section enables you to view the results of actions performed. 

 The Events section enables you to view events generated by certain program 
modules. 

4.1.2 Configuration 

You can define settings for your Avira product in the Configuration. After installation, your 
Avira product is configured with standard settings, ensuring optimal protection for your 
computer system. However, your computer system or your specific requirements for your 
Avira product may mean you need to adapt the protective components of the program. 
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The Configuration opens a dialog box: You can save your configuration settings via the 
OK or Apply buttons, delete your settings by clicking the Cancel button or restore your 
default configuration settings using the Default values button. You can select individual 
configuration sections in the left-hand navigation bar. 

Accessing the Configuration 

You have several options for accessing the configuration: 

 via the Windows control panel. 

 via the Windows Security Center - from Windows XP Service Pack 2. 

 via the Tray Icon of your Avira product. 

 in the Control Center via the menu item Extras > Configuration. 

 in the Control Center via the Configuration button. 

Note 
If you are accessing configuration via the Configuration button in the Control 
Center, go to the Configuration register of the section which is active in the 

Control Center.  
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Configuration operation 

Navigate in the configuration window as you would in Windows Explorer: 

  Click an entry in the tree structure to display this configuration section in the detail 
window. 

  Click the plus symbol in front of an entry to expand the configuration section and 
display configuration subsections in the tree structure. 

  To hide configuration subsections, click on the minus symbol in front of the expanded 
configuration section. 

Note 

To enable or disable Configuration options and use the buttons, you can also 
use the following key combinations: [Alt] + underlined letter in the option name 
or button description. 

  

If you want to confirm your Configuration settings: 

  Click OK. 

  The configuration window is closed and the settings are accepted. 

 - OR - 

  Click Apply. 

  The settings are applied. The configuration window remains open. 

If you want to finish configuration without confirming your settings: 

  Click Cancel. 

  The configuration window is closed and the settings are discarded. 

If you want to restore all configuration settings to default values: 

  Click Default values. 

  All settings of the configuration are restored to default values. All amendments 
and custom entries are lost when default settings are restored. 

Overview of configuration options 

The following configuration options are available: 

 System Scanner: Configuration of on-demand scan 

 Scan options 

 Action on detection  

 Archive scan options 

 System scan exceptions 
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 System scan heuristics 

 Report function setting 

 Real-Time Protection: Configuration of on-access scan 

 Scan options 

 Action on detection  

 Further actions 

 On-access scan exceptions 

 On-access scan heuristics 

 Report function setting 

 Update: Configuration of the update settings 

 Download via web server 

 Proxy settings 

 Web Protection: Configuration of Web Protection 

 Scan options, enabling and disabling the Web Protection 

 Action on detection 

 Blocked access: Unwanted file types and MIME types 

 Web Protection scan exceptions: URLs, file types, MIME types 

 Web Protection heuristics 

 Report function setting 

 General: 

 Threat categories for System Scanner and Real-Time Protection 

 Application filter: Block or allow applications 

 Password protection for access to the Control Center and the Configuration 

 Security: block autostart function, product protection, protect Windows hosts file  

 WMI: Enable WMI support 

 Event log configuration 

 Configuration of report functions 

 Setting of directories used 

 Configuration of acoustic alerts when malware is detected 

4.1.3 Tray icon 

After installation, you will see the tray icon of your Avira product in the system tray of the 

taskbar: 
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Icon Description 

 

Avira Real-Time Protection is 

enabled 

 

Avira Real-Time Protection is 

disabled 

The tray icon displays the status of the Real-Time Protection service. 

Central functions of your Avira product can be quickly accessed via the context menu of 
the tray icon. To open the context menu, click the tray icon with the right-hand mouse 

button. 

Entries in the context menu 

 Enable Real-Time Protection: Enables or disables the Avira Real-Time Protection. 

 Enable Web Protection: Enables or disables the Avira Web Protection. 

 Enable Windows Firewall: Enables or disables the Windows Firewall (this feature is 
available starting from Windows 8). 

 Start Avira Free Antivirus: Opens the Control Center. 

 Configure Avira Free Antivirus: Opens the Configuration. 

 My messages: Opens a slide-up with the current information about your Avira product. 

 Start update: Starts an update. 

 Help: opens the Online Help. 

 Experts Market - Ask for help: opens the Experts Market - Ask for help website where 
you can ask for help or offer your help to other users.  

 About Avira Free Antivirus: Opens a dialog box with information on your Avira 
product: Product information, Version information, License information. 

 Avira on the Internet: Opens the Avira web portal on the Internet. The condition for this 
is that you have an active connection to the Internet. 

Note 
The User Account Control (UAC) will ask for your permission to enable or 
disable the Real-Time Protection and Web Protection services in operating 
systems as of Windows Vista. 
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4.2 Avira SearchFree Toolbar 

Avira SearchFree Toolbar includes two main components: Avira SearchFree and the 
Toolbar. 

The Avira SearchFree Toolbar is installed as an add-on. When the browser is first 
accessed (in Firefox and Internet Explorer) a message will pop-up, asking you for 
permission to install the toolbar. You will have to accept in order to complete a successful 

installation of Avira SearchFree Toolbar. 

Avira SearchFree is a search engine and contains a clickable Avira logo linked to the Avira 
website and web, image and video channels. This allows Avira users a safer Internet 
navigation. 

The toolbar, integrated in your web browser, consists of a search box, an Avira logo linked 
to the Avira website, two status displays, three widgets and the Options menu. 

 Search toolbar 
Use the search toolbar for free to quickly search the Internet using the Avira search 
engine. 

 Status display 
The status displays provide information on the status of the Web Protection and the 
current update status of your Avira product and helps you identify which actions you 
need to take to protect your PC. 

 Widgets 
Avira offers you three widgets to the most important Internet-related functions. With one 
click you have direct access to Facebook and your email, or you can ensure safe web 
browsing (Firefox and Internet Explorer only). 

 Options 
You can use the Options menu to access the toolbar options, clear the history, find 
toolbar help and information and also uninstall the Avira SearchFree Toolbar directly via 
the web browser (Firefox and Internet Explorer only). 

4.2.1 Use 

Avira SearchFree 

You can use Avira SearchFree to define any number of terms to browse the Internet. 

Enter the term in the search box and press the Enter key or click on Search. The Avira 
SearchFree engine then searches the Internet for you and displays all hits in the browser 

window. 

To find out how to custom configure Avira SearchFree in Internet Explorer, Firefox and 
Chrome, go to Options. 

Status display 
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Web Protection  
You can use the following icons and messages to identify which actions you need to take 

to protect your PC:  

Icon Status display Description 

 

Web Protection If you move the cursor over the icon, the 
following message appears: Avira Web 

Protection is active. Your browsing is protected. 

No further action is necessary. 

 

Web Protection is 
inactive 

If you move the cursor over the icon, the 
following message appears: Avira Web 
Protection is off. Click to find out how to turn it 

on. 

  You will be redirected to one of our 
Knowledge Base articles. 

 

No Web Protection If you move the cursor over the icon, one of the 
following messages appears: 

 You do not have Avira Web Protection installed. Click to find 

out how to protect your browsing.  

 This message will appear if you install 

incorrectly or uninstall the Avira Antivirus. 

 Web Protection is included for free with Avira Antivirus. Click 

to find out how to install it.  

 This message will appear if you do not install 

Web Protection or if you uninstall it. 

  In both cases, you will be redirected to 
the Avira homepage, where you can 
download the Avira product . 

 

Error If you move the cursor over the icon, the 
following message appears: Avira reported an 

error. Click to contact Support for help. 

  Click the gray icon or text to go to the Avira 

Support page. 
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Widgets 

Avira SearchFree contains three widgets with the most important functions for the 

nowadays Internet web browsing:  Facebook, E-mail and  Browser Security. 

Facebook 
 
This function allows you to receive all the messages from Facebook and to be always 

updated. 

Email 
 
If you click the email symbol in the toolbar, a dropdown list  will be shown. You can choose 

between the most commonly used email providers. 

Browser Security 
 
This widget has been conceived to offer you in one click all the Internet security options 
you may need on daily basis. This option is only available for Firefox and Internet Explorer. 
Also the names of the functions sometimes change from one browser to another:  

 Pop-up Blocker 

If this option is activated, all pop-up windows will be blocked. 

 Block Cookies 

If you activate this option, no cookies will be saved on your computer. 

 Private Browsing (Firefox) / InPrivate Browsing (Internet Explorer) 

 Enable this option if you do not want to leave any personal information on the Internet 
while you surf. This option is not available for Internet Explorer 7 and 8. 

 Clear Recent History (Firefox) / Delete Browsing History (Internet Explorer) 

With this option you will erase all traces of your Internet activities. 

Website Safety Advisor 
 
The Website Safety Advisor offers you a safety ranking while navigating.  
You can assess the reputation of the website you are visiting, and check if it poses a low 
or a high risk to your security. 

This widget also provides further information on the website, like who is the domain owner, 

or why the website has been categorized as safe or risky.  

The status of the Website Safety Advisor is displayed in the Toolbar and in your search 
results, as an Avira tray icon in combination with other icons: 



 Overview of Avira Free Antivirus 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 45 

Icon Status display Description 

 

Safe A green check mark for safe websites. 

 

Low risk A yellow exclamation mark for websites 
representing a low risk. 

 

High risk A red stop sign for websites representing a high 

risk to your security. 

 

Unknown A grey question mark will appear when the status 
is unknown. 

 

Verifying This sign will appear while verifying the status of 

a website. 

Browser Tracking Blocker 
 
With the Browser Tracking Blocker you can stop trackers from collecting information about 
you while you are surfing.  
The widget allows you to choose which trackers to block and which ones to allow.  

The tracking companies are classified in three categories:  

 Social Networks 

 Ad Networks 

 Other companies 

4.2.2 Options 

Avira SearchFree Toolbar is compatible with Internet Explorer, Firefox  and Google 
Chrome and can be configured in the three web browsers: 

 Internet Explorer configuration options 

 Firefox configuration options 

 Google Chrome configuration options 

Internet Explorer 

In Internet Explorer, the following configuration options for the Avira SearchFree Toolbar 
are available in the Options menu: 
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Toolbar options 

Search 

Avira search engine 

In the Avira search engine menu, you can select which search engine to use for the 
search. Search engines are available for the USA, Brazil, Germany, Spain, Europe, 

France, Italy, the Netherlands, Russia and the United Kingdom. 

Open searches in 

In the Open searches in option menu, you can select where the search result should 
be displayed; in the Current window, in a New window or on a New tab. 

Display recent searches 

If the Display recent searches option is enabled, you can display previous search 
terms under the text entry box of the search toolbar. 

Auto clear recent search history when I close the browser 

Enable the option Auto clear recent search history when I close the browser if you 
do not want to save previous searches and want to clear the history when you close 
the web browser. 

More options 

Select toolbar language 

Under Select toolbar language you can select the language in which Avira 
SearchFree Toolbar is displayed. The toolbar is available in English, German, 
Spanish, French, Italian, Portuguese and Dutch. 

Note 
Where possible, the default Avira SearchFree Toolbar language corresponds to 
that of your program. If the toolbar is not available in your language, the default 
language is English. 

Show button text labels 

Disable the Show button text labels option if you want to hide the text next to the 
Avira SearchFree Toolbar icons. 

Clear history 

Enable the Clear history option if you do not want to save previous searches and 
want to clear the history immediately. 

Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 
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Uninstall 

You can also uninstall Avira SearchFree Toolbar directly in Internet Explorer: 
Uninstallation via the web browser 

About 

Click on About to display which version of Avira SearchFree Toolbar is installed. 

Firefox 

In the Firefox web browser, the following configuration options for the Avira SearchFree 

Toolbar are available in the Options menu: 

Toolbar options 

Search 

Select Avira search engine 

In the Avira search engine menu, you can select which search engine to use for the 
search. Search engines are available for the USA, Brazil, Germany, Spain, Europe, 
France, Italy, the Netherlands, Russia and the United Kingdom. 

Display recent searches 

If the Display recent searches option enabled, you can display previous search terms 
by clicking on the arrow in the search toolbar. Select a term if you want to display the 

search result again. 

Auto clear recent search history when I close the browser 

Enable the option Auto clear recent search history when I close the browser if you 
do not want to save previous searches and want to clear the history when you close 

the web browser. 

Display Avira search results when I type keywords or invalid URLs into the 
browser address bar 

If this option is enabled, a search is initiated and the search result displayed every time 
you enter keywords or an invalid URL into the web browser's address bar. 

More options 

Select toolbar language 

Under Select toolbar language you can select the language in which Avira 
SearchFree Toolbar is displayed. The toolbar is available in English, German, 

Spanish, French, Italian, Portuguese and Dutch. 

Note 
Where possible, the default Avira SearchFree Toolbar language corresponds to 



 Overview of Avira Free Antivirus 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 48 

that of your program. If the toolbar is not available in your language, the default 
language is English. 

Show button text labels 

Disable the Show button text labels option if you want to hide the text next to the 
Avira SearchFree Toolbar icons. 

Clear history 

Enable the Clear history option if you do not want to save previous searches and 
want to clear the history immediately. 

Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 

Uninstall 

You can also uninstall Avira SearchFree Toolbar directly in Firefox: Uninstallation via 
the web browser. 

About 

Click on About to display which version of Avira SearchFree Toolbar is installed. 

Google Chrome 

In the Chrome web browser, the following configuration options for Avira SearchFree 
Toolbar are available under the menu of the red Avira umbrella: 

Help 

Click on Help to access the website containing frequently asked questions (FAQs) 
relating to the toolbar. 

Uninstall instructions 

Here you will be linked to the articles that contain all the information you need to 
uninstall the toolbar. 

About 

Click on About to display which version of the Avira SearchFree Toolbar is installed. 
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Show/ Hide the Avira SearchFree Toolbar 

Click here to hide or show Avira SearchFree Toolbar on your web browser. 

4.2.3 Uninstalling Avira SearchFree Toolbar 

Should you ever feel the need to uninstall Avira SearchFree Toolbar, here is how: 

 Uninstalling Avira SearchFree Toolbar under Windows 8 

 Uninstalling Avira SearchFree Toolbar under Windows 7 

 Uninstalling Avira SearchFree Toolbar under Windows XP 

 Uninstalling Avira SearchFree Toolbar via the web browser 

 Uninstalling Avira SearchFree Toolbar via Add-On Manager 

Note 
If you uninstall the Avira SearchFree Toolbar, Web Protection is also 
uninstalled. 

4.3 How to...? 

The chapters "How to...?" offer short instructions about license and product activation as 
well as information on the most important functions of your Avira product. The selected 
short articles serve as an overview about the functionality of your Avira product. They do 

not substitute the detailed information of each section of this help center. 

4.3.1 Perform automatic updates 

To create a job with the Avira Scheduler to update your Avira product automatically: 

  In the Control Center, select the section ADMINISTRATION > Scheduler. 

  Click the   Insert new job icon. 

  The dialog box Name and description of the job appears. 

  Give the job a name and, where appropriate, a description. 

  Click Next. 

  The dialog box Type of job is displayed. 

  Select Update job from the list. 

  Click Next. 

  The dialog box Time of job appears. 

  Select a time for the update: 

 Immediately 
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 Daily 

 Weekly 

 Interval 

 Single 

Note 
We recommend regular automatic updates. The recommended update interval 

is: 6 hours. 

  Where appropriate, specify a date according to the selection. 

  Where appropriate, select additional options (availability depends on type of job): 

 Repeat job if time has expired 
Past jobs are performed that could not be performed at the required time, for 
example because the computer was switched off. 

  Click Next. 

  The dialog box Select display mode appears. 

  Select the display mode of the job window: 

 Invisible: No job window 

 Minimize: progress bar only 

 Maximize: Entire job window 

  Click Finish. 

  Your newly created job appears on the start page of the ADMINISTRATION > 
Scheduler section with the status enabled (check mark). 

  Where appropriate, deactivate jobs that are not to be performed. 

Use the following icons to further define your jobs: 

    View properties of a job 

    Edit job 

    Delete job 

    Start job 

    Stop job 
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4.3.2 Start a manual update 

You have various options for starting an update manually: When an update is started 

manually, the virus definition file and scan engine are always updated.  

To start an update of your Avira product manually: 

  With the right-hand mouse button, click the Avira tray icon in the taskbar. 

  A context menu appears. 

  Select Start update. 

  The Updater dialog box appears. 

- OR - 

  In the Control Center, select Status. 

  In the Last update field, click on the Start update link. 

  The Updater dialog box appears. 

- OR - 

  In the Control Center, in the Update menu, select the menu command Start update. 

  The Updater dialog box appears. 

Note 
We recommend regular automatic updates. The recommended update interval 

is: 6 hours. 

  

Note 
You can also carry out a manual update directly via the Windows security 

center. 

4.3.3 Using a scan profile to scan for viruses and malware 

A scan profile is a set of drives and directories to be scanned. 

The following options are available for scanning via a scan profile: 

Use predefined scan profile 

If the predefined scan profile corresponds to your requirements. 

Customize and apply scan profile (manual selection) 

If you want to scan with a customized scan profile. 
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Depending on the operating system, various icons are available for starting a scan profile: 

 In Windows XP: 

  This icon starts the scan via a scan profile.  

 As of Windows Vista: 

 As of Microsoft Windows Vista, the Control Center only has limited rights at the 
moment, e.g. for access to directories and files. Certain actions and file accesses 
can only be performed in the Control Center with extended administrator rights. 
These extended administrator rights must be granted at the start of each scan via a 
scan profile. 

 This icon starts a limited scan via a scan profile. Only directories and files that 
the operating system has granted access rights to are scanned. 

 This icon starts the scan with extended administrator rights. After confirmation, all 
directories and files in the selected scan profile are scanned. 

To scan for viruses and malware with a scan profile: 

  Go to Control Center and select the section PC PROTECTION > System Scanner. 

  Predefined scan profiles appear. 

  Select one of the predefined scan profiles. 

 -OR- 

 Adapt the scan profile Manual selection. 

  Click the icon (Windows XP:  or as of Windows Vista:   ). 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 

If you want to adapt a scan profile: 

  In the scan profile Manual Selection, expand the file tree so that all the drives you 
want to scan are open: 

  Highlight the nodes you want to scan by clicking on the box  

4.3.4 Scan for viruses and malware using drag & drop 

To scan for viruses and malware systematically using drag & drop: 

  The Control Center of your Avira product has been opened. 

  Highlight the file you want to scan. 

  Use the left-hand mouse button to drag the highlighted file into the Control Center. 

  The Luke Filewalker window appears and a system scan is started. 
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  When the scan is completed, the results are displayed. 

4.3.5 Scan for viruses and malware via the context menu 

To scan for viruses and malware systematically via the context menu: 

  Click with the right-hand mouse button (e.g. in Windows Explorer, on the desktop or 
in an open Windows directory) on the file you want to scan. 

  The Windows Explorer context menu appears. 

  Select Scan selected files with Avira in the context menu. 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 

4.3.6 Automatically scan for viruses and malware 

Note 
After installation, the scan job Full system scan is created in the Scheduler: A 

complete system scan is automatically performed at a recommended interval. 

To create a job to automatically scan for viruses and malware: 

  In the Control Center, select the section ADMINISTRATION > Scheduler. 

  Click the icon . 

  The dialog box Name and description of job appears. 

  Give the job a name and, where appropriate, a description. 

  Click Next. 

  The dialog box Type of job appears. 

  Select Scan job. 

  Click Next. 

  The dialog box Selection of the profile appears. 

  Select the profile to be scanned. 

  Click Next. 

  The dialog box Time of the job appears. 

  Select a time for the scan: 

 Immediately 

 Daily 

 Weekly 

 Interval 
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 Single 

  Where appropriate, specify a date according to the selection. 

  Where appropriate, select the following additional options (availability depends on job 
type): 

Repeat job if the time has already expired 

Past jobs are performed that could not be performed at the required time, for example 
because the computer was switched off. 

  Click Next. 

  The dialog box Selection of the display mode appears. 

  Select the display mode of the job window: 

 Invisible: No job window 

 Minimized: progress bar only 

 Maximized: Entire job window 

  Select the Shut down computer if job is done option if you want the computer to 
shut down automatically when the scan is finished. This option is only available if the 
display mode is set to minimized or maximized. 

  Click Finish. 

  Your newly created job appears on the start page of the ADMINISTRATION > 
Scheduler section with the status enabled (check mark). 

  Where appropriate, deactivate jobs that are not to be performed. 

Use the following icons to further define your jobs: 

    View properties of a job 

    Edit job 

    Delete job 

    Start job 

    Stop job 

4.3.7 Targeted scan for Rootkits and active malware 

To scan for active rootkits, use the predefined scan profile Scan for Rootkits and active 

malware. 

To scan for active rootkits systematically: 
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  Go to Control Center and select the section PC PROTECTION > System Scanner. 

  Predefined scan profiles appear. 

  Select the predefined scan profile Scan for Rootkits and active malware. 

  Where appropriate, highlight other nodes and directories to be scanned by clicking 
the check box of the directory level. 

  Click the icon (Windows XP:  or as of Windows Vista:   ). 

  The Luke Filewalker window appears and a system scan is started. 

  When the scan is completed, the results are displayed. 

4.3.8 React to detected viruses and malware 

For the individual protection components of your Avira product, you can define how your 
Avira product reacts to a detected virus or unwanted program in the Configuration under 
the section Action on detection. 

There are no configurable action options with the Real-Time Protection component. When 
a virus or unwanted program is detected, you will receive a desktop notification. In the 
desktop notification you can remove the detected malware or forward the  malware using 
the Details button to the System Scanner component for further virus management. The 
System Scanner opens a window containing notification of the detection, which gives you 
various options for managing the affected file via a context menu (see Detection > System 

Scanner): 

Action options for the System Scanner: 

Interactive 

In interactive action mode, the results of the System Scanner scan are displayed in a 
dialog box. This option is enabled as the default setting. 

In the case of System Scanner scan, you will receive an alert with a list of the 
affected files when the scan is complete. You can use the content-sensitive menu to 
select an action to be executed for the various infected files. You can execute the 
standard actions for all infected files or cancel the System Scanner. 

Automatic 

In automatic action mode, when a virus or unwanted program is detected the action 
you selected in this area is executed automatically.  

Action options for Web Protection: 

Interactive 

In interactive action mode, if a virus or unwanted program is detected, a dialog box 
appears in which you can select what to do with the infected object. This option is 

enabled as the default setting. 
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Automatic 

In automatic action mode, when a virus or unwanted program is detected the action 
you selected in this area is executed automatically.  

In interactive action mode, you can react to detected viruses and unwanted programs by 
selecting an action for the infected object in the alert and executing the selected action by 

clicking Confirm. 

The following actions for handling infected objects are available for selection: 

Note 
Which actions are available for selection depends on the operating system, the 

protection components (Avira Real-Time Protection, Avira Mail Protection, Avira 
Web Protection) reporting the detection, and the type of malware detected. 

Actions of the System Scanner: 

Repair 

The file is repaired. 

This option is only available if the infected file can be repaired. 

Rename 

The file is renamed with a *.vir extension. Direct access to these files (e.g. with double-

click) is therefore no longer possible. Files can be repaired and given their original 
name at a later time. 

Quarantine 

The file is packaged into a special format (*.qua) and moved to the Quarantine 
directory INFECTED on your hard disk, so that direct access is no longer possible. 

Files in this directory can be repaired in Quarantine at a later data or, if necessary, 

sent to Avira. 

Delete 

The file will be deleted. If a boot sector virus is detected, this can be deleted by 

deleting the boot sector. A new boot sector is written. 

Ignore 

No further action is taken. The infected file remains active on your computer. 

Warning 
This could result in loss of data and damage to the operating system! Only 
select the Ignore option in exceptional cases. 
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Always ignore 

Action option for Real-Time Protection detections: No further action is taken by Real-
Time Protection. Access to the file is permitted. All further access to this file is 
permitted and no further notifications will be provided until the computer is restarted or 

the virus definition file is updated. 

Warning 
This could result in loss of data and damage to the operating system! Only 

select the Always ignore option in exceptional cases. 

Copy to quarantine 

Action option for a rootkits detection: The detection is copied to quarantine. 

Repair boot sector | Download repair tool 

Action options when infected boot sectors are detected: A number of options are 
available for repairing infected diskette drives. If your Avira product is unable to 
perform the repair, you can download a special tool for detecting and removing boot 

sector viruses. 

Note 
If you carry out actions on running processes, the processes in question are 
terminated before the actions are performed. 

The website requested from the web server and/or any data or files transferred are 
moved to quarantine. The affected file can be recovered from quarantine manager if it 
has an informative value or - if necessary - sent to the Avira Malware Research 

Center. 

 

4.3.9 Handling quarantined files (*.qua) 

To handle quarantined files: 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 

  Check which files are involved, so that, if necessary, you can reload the original back 
onto your computer from another location. 

If you want to see more information on a file: 

  Highlight the file and click on  . 

  The dialog box Properties appears with more information on the file. 
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If you want to rescan a file: 

Scanning a file is recommended if the virus definition file of your Avira product has been 
updated and a false positive report is suspected. This enables you to confirm a false 
positive with a rescan and restore the file. 

  Highlight the file and click on  . 

  The file is scanned for viruses and malware using the system scan settings. 

  After the scan, the dialog Rescan statistics appears which displays statistics on 
the status of the file before and after the rescan. 

To delete a file: 

  Highlight the file and click on  . 

  You have to confirm your choice with Yes. 

If you want to upload the file to a Avira Malware Research Center web server for analysis: 

  Highlight the file you want to upload. 

  Click on   . 

  A dialog opens with a form for inputting your contact data. 

  Enter all the required data. 

  Select a type: Suspicious file or Suspicion of false positive. 

  Select a response format: HTML, Text, HTML & Text. 

  Click OK. 

  The file is uploaded to a Avira Malware Research Center web server in 
compressed form. 

Note 
In the following cases, analysis by the Avira Malware Research Center is 
recommended: 
Heuristic hits (Suspicious file): During a scan, a file has been classified as 
suspicious by your Avira product and moved to quarantine: Analysis of the file 

by the Avira Malware Research Center has been recommended in the virus 

detection dialog box or in the report file generated by the scan. 

  

Note 
The size of the files you upload is limited to 20 MB uncompressed or 8 MB 

compressed. 
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Note 

You can only upload one file at a time.  

If you want to export the properties of a quarantined object to a text file: 

  Highlight the quarantined object and click on  . 

  The text file quarantaene - Notepad opens containing the data from the selected 
quarantined object. 

  Save the text file. 

You can also restore the files in quarantine (see Chapter: Quarantine: Restore the files in 

quarantine). 

4.3.10 Restore the files in quarantine 

Different icons control the restore procedure, depending on the operating system: 

 In Windows XP: 

 This icon restores the files to their original directory. 

 This icon restores the files to a directory of your choice. 

 As of Windows Vista: 

 As of Microsoft Windows Vista, the Control Center only has limited rights at the 
moment, e.g. for access to directories and files. Certain actions and file accesses 
can only be performed in the Control Center with extended administrator rights. 
These extended administrator rights must be granted at the start of each scan via a 
scan profile. 

 This icon restores the files to a directory of your choice. 

 This icon restores the files to their original directory. If extended administrator 
rights are necessary to access this directory, a corresponding request appears. 

To restore files in quarantine: 

Warning 
This could result in loss of data and damage to the operating system of the 
computer! Only use the function Restore selected object in exceptional cases. 
Only restore files that could be repaired by a new scan. 

  File rescanned and repaired. 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 
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Note 

Emails and email attachments can only be restored using the option  if the 
file extension is *.eml. 

To restore a file to its original location: 

  Highlight the file and click the icon (Windows XP:  , as of Windows Vista   ). 

This option is not available for emails. 

Note 

Emails and email attachments can only be restored using the option  if the 
file extension is *.eml. 

  A message appears asking if you want to restore the file. 

  Click Yes. 

  The file is restored to the directory it was in before it was moved to quarantine. 

To restore a file to a specified directory: 

  Highlight the file and click on  . 

  A message appears asking if you want to restore the file. 

  Click Yes. 

  The Windows default window Save As for selecting the directory appears. 

  Select the directory to restore the file to and confirm. 

  The file is restored to the selected directory. 

4.3.11 Move suspicious files to quarantine 

To move a suspect file to quarantine manually: 

  In the Control Center, select the section ADMINISTRATION > Quarantine section. 

  Click on   . 

  The Windows default window for selecting a file appears. 

  Select the file and confirm with Open. 

  The file is moved to quarantine. 
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You can scan files in quarantine with the Avira System Scanner (see Chapter: Quarantine: 
Handling quarantined files (*.qua)). 

4.3.12 Amend or delete file type in a scan profile 

To stipulate additional file types to be scanned or exclude specific file types from the scan 

in a scan profile (only possible for manual selection ): 

  In the Control Center, go to the PC PROTECTION > System Scanner section. 

  With the right-hand mouse button, click on the scan profile you want to edit. 

  A context menu appears. 

  Select File filter. 

  Expand the context menu further by clicking on the small triangle on the right-hand 
side of the context menu. 

  The entries Default, Scan all files and User-defined appear. 

  Select User-defined. 

  The File extensions dialog box appears with a list of all file types to be scanned 
with the scan profile. 

If you want to exclude a file type from the scan: 

  Highlight the file type and click Delete. 

If you want to add a file type to the scan: 

  Highlight a file type. 

  Click Insert and enter the file extension of file type into the input box. 

Use a maximum of 10 characters and do not enter the leading dot. Wildcards (* and ?) 

are allowed. 

4.3.13 Create desktop shortcut for scan profile 

You can start a system scan directly from your desktop via a desktop shortcut to a scan 

profile without accessing your Avira product’s Control Center. 

To create a desktop shortcut to the scan profile: 

  In the Control Center, go to the PC PROTECTION > System Scanner section. 

  Select the scan profile for which you want to create a shortcut. 

  Click the icon  . 

  The desktop shortcut is created. 
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4.3.14 Filter events 

Events that have been generated by program components of your Avira product are 
displayed in the Control Center under ADMINISTRATION > Events (analogous to the 
event display of your Windows operating system). The program components, in 

alphabetical order, are the following: 

 Helper Service 

 Real-Time Protection 

 Scheduler 

 System Scanner 

 Updater 

 Web Protection 

The following event types are displayed: 

 Information 

 Warning 

 Error 

 Detection 

To filter displayed events: 

  In the Control Center, select the section ADMINISTRATION > Events. 

  Check the box of the program components to display the events of the activated 
components. 

 - OR - 

 Uncheck the box of the program components to hide the events of the deactivated 
components. 

  Check the event type box to display these events. 

 - OR - 

 Uncheck the event type box to hide these events. 
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5. Detection 

5.1 Overview 

When a virus is detected, your Avira can automatically execute certain actions or respond 
interactively. In interactive action mode, a dialog opens when a virus is detected in which 
you can control or initiate the subsequent handling of the virus (delete, ignore, etc). There 
is an option in automatic mode for displaying an alert when a virus is detected. The action 

that was automatically executed is displayed in the message. 

This chapter contains comprehensive information, arranged according to module, on 

detection messages. 

 see Chapter System Scanner: Interactive action mode 

 see Chapter Real-Time Protection 

 see Chapter Web Protection 

5.2 Interactive action mode  

If you selected Interactive mode as the action mode when a virus is detected, you will 

receive an alert containing a list of the affected files when the scan is complete (see the 
configuration section System Scanner > Scan > Action on detection).  
You can use the content-sensitive menu to select an action to be executed for the various 
infected files. You can execute the standard actions for all infected files or cancel the 
System Scanner. 

Note 
If reporting is enabled, the System Scanner enters each detection in the Report 

file. 
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5.2.1 Alert 

 

5.2.2 Detection, Errors, Warnings 

Detailed information, action options for the detected viruses and messages will be 
displayed in the Detection, Errors and Warnings tabs: 

 Detection: 

 Object: File name of the affected file 

 Detection: Name of the virus or unwanted program 

 Action: Selected action with which the affected file is to be handled 

 You can choose other actions for dealing with the malware from the context menu 
associated with the displayed action. 

 Error: Messages about errors that occurred during the scan 

 Alerts: Alerts relating to the viruses that were detected 

Note 
The following information is displayed in the tooltip for the object: Name of the 
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affected file and full path, name of the virus and action that is executed with the 
Apply Now button. 

  

Note 
The default action of the System Scanner is displayed as the action to be 
executed. The default action of the System Scanner for handling affected files is 

to move the relevant files to quarantine. 

5.2.3 Context menu actions 

Note 
If the detection is a heuristic hit (HEUR/), an unusual runtime packer (PCK/) or a 
file with a hidden file extension (HEUR-DBLEXT/), in interactive mode only the 
options Move to quarantine and Ignore are available. In automatic mode the 
detection is automatically moved to Quarantine.  
This restriction prevents the detected files, which may be a false alarm, being 
directly removed (deleted) from your computer. The file can be recovered at any 

time with the aid of the Quarantine Manager.  

Repair 

If this option is enabled, the Scanner repairs the affected file. 

Note 
The option Repair can only be enabled if a repair of the detected file is 

possible. 

Quarantine 

If this option is enabled, the Scanner moves the file to quarantine. The file can be 
recovered from quarantine manager if it has an informative value or - if necessary - 
sent to the Avira Malware Research Center. Depending on the file, further selection 

options may be available in the Quarantine Manager. 

Delete 

If this option is enabled, the file is deleted. 

Rename 

If this option is enabled, the Scanner renames the file. Direct access to these files (e.g. 
with double-click) is therefore no longer possible. Files can later be repaired and given 

their original names again. 
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Ignore 

If this option is enabled, access to the file is allowed and the file is left as it is. 

Always ignore 

Action option for Real-Time Protection detections: No further action is taken by Real-
Time Protection. Access to the file is permitted. All further access to this file is 
permitted and no further notifications will be provided until the computer is restarted or 

the virus definition file is updated. 

Warning 
If you select the option Ignore or Always ignore, the affected files remain 
active on your computer! It may cause serious damage on your workstation! 

5.2.4 Special features when infected boot sectors, rootkits and active malware are 
detected 

Action options are available for repairing infected boot sectors when they are detected: 

Repair 722 KB | 1.44 MB | 2.88 MB | 360 KB | 1.2 MB boot sector 

These options are available for diskette drives. 

Download rescue CD 

This option will take you to the Avira website, from where you can download a special 
tool for detecting and removing boot sector viruses. 

If you carry out actions on running processes, the processes in question are 

terminated before the actions are carried out. 

5.2.5 Buttons and links 

Button / link Beschreibung 

Apply Now The selected actions are executed to handle all affected 

files. 

Cancel The Scanner is closed without further action. The affected 

files are left unchanged on your computer system. 
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This page of the online help is opened via this button or 
link. 

Warning 
Only execute the Cancel action in exceptional cases. The affected files remain 

active on your workstation after you cancel! It may cause serious damage on 

your workstation! 

5.2.6 Special features when malware is detected while Web Protection is inactive 

If you have disabled the Web Protection, the System Scanner reports active malware it 
has detected via a slide-up while scanning the system. Prior to repairing your system you 

can create a restore point. 

  First you have to enable System Restore on your Windows system. 

  Click Details in the slide up. 

  The window System is being scanned is displayed. 

  Enable Create system restore point before repair. 

  Click Apply. 

  A system restore point has been created. Now you can perform a system restore 
using the Windows Control Panel if necessary. 

5.3 Real-Time Protection 

If viruses are detected by Real-Time Protection, file access is denied and a desktop 

notification is displayed 

Notification 

The following information is displayed in the notification: 

 Date and time of the detection 

 Path and name of the affected file 

 Name of the malware 

Note 
When the default start mode for Real-Time Protection (Normal start) has been 
chosen and the logon process upon startup is carried out fast, programs 
configured to start automatically upon startup might not be scanned because 
they might be up and running before the Real-Time Protection has been started 
completely. 
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In interactive mode you have the following options: 

Remove 

The affected file is transferred to the System Scanner component and deleted by the 

System Scanner. No further message appears. 

Details 

The affected file is transferred to the System Scanner component. The System 
Scanner opens a window containing notification of the detection and various options 
for managing the affected file. 

Note 

Please note the information on virus management under Detection > System 

Scanner. 

  

Note 
The action Quarantine is pre-selected by default in the System Scanner 

notification. Further actions can be selected via a context menu. 

  

Close 

The message is closed. Virus management is terminated. 

5.4 Web Protection 

If viruses are detected by Web Protection, you will receive an alert if you have selected 
interactive option (see the configuration section Web Protection > Scan > Action on 
detection). In interactive mode you can choose what to do with the data sent by the web 

server in the dialog box.  
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Alert 

 

Detection, Errors, Warnings 

Messages and detailed information relating to the viruses detected are displayed in the 

Detection, Errors and Warnings tabs: 

 Detection: URL and the name of the detected virus or unwanted program 

 Error: Messages about errors that occurred during the Web Protection scan 

 Alerts: Warnings relating to the viruses that were detected 

Possible actions 

Note 
If a detection is a heuristic hit (HEUR/), an unusual runtime packer (PCK/) or a 
file with a hidden file extension (HEUR-DBLEXT/), in interactive mode only the 
options Move to quarantine and Ignore are available. 
This restriction prevents the detected files, which may be a false alarm, being 
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directly removed (deleted) from your computer. The file can be recovered at any 
time with the aid of the quarantine manager.  

Deny access 

The website requested from the web server and/or any data or files transferred are not 
sent to your web browser. An error message to notify you that access has been denied 
is displayed in the web browser. Web Protection logs the detection to the report file if 
the report function is activated. 

Move to quarantine 

In the event of a virus or malware being detected, the website requested from the web 
server and/or the transferred data and files are moved into quarantine. The affected 

file can be recovered from quarantine manager if it has an informative value or - if 

necessary - sent to the Avira Malware Research Center. 

Ignore 

The website requested from the web server and/or the data and files that were 

transferred are forwarded on by Web Protection to your web browser. 

Warning 
This could allow viruses and unwanted programs to access your computer 

system. Only select the Ignore option in exceptional cases. 

Buttons and links 

Button / link Description 

 

With this link - and with an active 
Internet connection - you can 
access an Internet page with 
further information on this virus or 

unwanted program. 

 

This page of the online help is 
opened via this button or link. 
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6. System Scanner 

6.1 System Scanner 

With the System Scanner component, you can carry out targeted scans (on-demand 
scans) for viruses and unwanted programs. The following options are available for 
scanning for infected files: 

 System scan via context menu 
The system scan via the context menu (right-hand mouse button - entry Scan selected 
files with Avira) is recommended if, for example, you wish to scan individual files and 
directories. Another advantage is that it is not necessary to first start the Control Center 
for a system scan via the context menu. 

 System scan via drag & drop 
When a file or directory is dragged into the program window of the Control Center, the 
System Scanner scans the file or directory and all sub-directories it contains. This 
procedure is recommended if you wish to scan individual files and directories that you 
have saved, for example, on your desktop. 

 System scan via profiles 
This procedure is recommended if you wish to regularly scan certain directories and 
drives (e.g. your work directory or drives on which you regularly store new files). You do 
not then need to select these directories and drives again for every new scan, you 
simply select using the relevant profile.  

 System scan via the Scheduler 
The Scheduler enables you to carry out time-controlled scans. 

Special processes are required when scanning for rootkits, boot sector viruses, and when 
scanning active processes. The following options are available: 

 Scan for rootkits via the scan profile Scan for Rootkits and active malware 

 Scan active processes via the scan profile Active processes 

 Scan for boot sector viruses via the menu command Boot records scan... in the menu 
Extras 

6.2 Luke Filewalker 

During a system scan, the status window Luke Filewalker appears, which provides you 

with exact information on the status of the scan. 

If the option interactive is selected in the configuration of the System Scanner in the 
group Action on detection, you are asked what is to be done with a detected virus or 
unwanted program. If the option automatic is selected, any detections are shown in the 

Scanner report. 
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When the scan is complete, its results (statistics), alerts and error messages are displayed 
in a new dialog box. 

6.2.1 Luke Filewalker: Scan status window 

 

Displayed information 

Status: There are different status messages:  

 The program will be initialized 

 Hidden objects search is running! 

 Scanning the started processes 

 Scanning file 

 Initialize archive 

 Free memory 

 File is being unpacked 

 Scanning boot sectors 

 Scanning master boot sectors 

 Scanning the registry 
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 The program will be ended! 

 The scan has finished 

Last object: Name and path of the file that is currently being scanned or that was most 

recently scanned 

Last detection: There are various messages for the last detection: 

 No detection! 

 Name of the most recently detected virus or unwanted program 

Scanned files: Number of scanned files 

Scanned directories: Number of scanned directories 

Scanned archives: Number of scanned archives 

Used time: Duration of the system scan 

Scanned: Percentage of scan already completed 

Detections: Number of viruses and unwanted programs detected 

Suspicious files: Number of files reported by the heuristics 

Warnings: Number of alerts about detected viruses 

Objects scanned: Number of objects scanned during the rootkits scan 

Hidden objects: Total number of hidden objects detected 

Note 
Rootkits have the ability to hide processes and objects, such as registry entries 
or files. However not every hidden object is necessarily proof of the existence of 
a rootkit. Hidden objects can also be harmless objects. If a scan detects hidden 
objects but does not issue a virus detection alert, you should use the report to 
determine which object is referred to and obtain more information about the 

detected object. 
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Buttons and links 

Button / Link Description 

 

With this link - and with an active Internet 
connection - you can access an Internet page 
with further information on this virus or 

unwanted program. 

 

This page of the online help is opened via this 

button or link. 

Stop The scan process is stopped. 

Pause The scan will be interrupted and can be 
continued by clicking on the button Resume. 

Resume The interrupted scan will be continued. 

End The System Scanner is closed. 
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Report The report file of the scan will be shown. 

6.2.2 Luke Filewalker: Scan Statistics 

 

Displayed information: Statistics 

Files: Number of scanned files 

Directories: Number of scanned directories 

Archives: Number of scanned archives 

Warnings: Number of alerts about detected viruses 

Objects searched: Number of objects scanned during the rootkits scan 

Hidden objects: Number of detected hidden objects (rootkits) 

Detections: Number of viruses and unwanted programs detected 

Suspicious: Number of files reported by the heuristics 
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Repaired: Number of repaired files 

Wiped: Number of overwritten files 

Deleted: Number of deleted files 

Moved: Number of files that are moved to quarantine 

Buttons and links 

Button / Link Description 

 

This page of the online help is opened via 
this button or link. 

Close The summary window is closed. 

Report The report file of the scan will be shown. 
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7. Control Center  

7.1 Control Center Overview 

The Control Center is an information, configuration and management center. In addition to 
the sections that can be selected individually, it offers a large number of options that can 
be accessed from the menu bar. 

Menu bar 

All functions of the Control Center are contained in the menu bar. 

File 

 Exit (Alt + F4) 

View 

 Status 

 PC Protection 

 System Scanner 

 Real-Time Protection 

 Internet Protection 

 FireWall 

 Web Protection 

 Child Protection 

 Social Networks 

 Mobile Protection 

 Avira Android Security 

 Administration 

 Quarantine 

 Scheduler 

 Reports 

 Events 

 Refresh (F5) 

Extras 

 Boot records scan... 

 Detection list... 
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 Configuration (F8) 

Update 

 Start update... 

 Manual update... 

Help 

 Topics 

 Help me 

 Forum 

 Download manual 

 License management 

 Recommend product 

 Send feedback 

 Show notifier again 

 About Avira Free Antivirus 

Note 
You can activate the keyboard navigation in the menu bar with the help of the 
[ALT] key. If navigation is activated, you can move within the menu with the 
arrow keys. With the Return key you activate the active menu item. 

Navigation sections 

In the left-hand navigation bar you find the following sections: 

 Status 

PC PROTECTION 

 System Scanner 

 Real-Time Protection  

INTERNET PROTECTION 

 FireWall 

 Web Protection 

CHILD PROTECTION 

 Social Networks 

MOBILE PROTECTION 
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 Avira Android Security 

ADMINISTRATION 

 Quarantine 

 Scheduler 

 Reports 

 Events 

Navigation description 

 Status: Clicking on the Status bar gives you an overview of the product's functionality 

and performance (see Status). 

 The Status section lets you see at a glance which modules are active and provides 
information on the last update performed.  

 PC PROTECTION: In this section you will find the components for checking the files on 
your computer system for viruses and malware. 

 The System Scanner section enables you to easily configure and start an on-demand 
scan. Predefined profiles enable a scan with already adapted default options. In the 
same way it is possible to adapt the scan for viruses and unwanted programs to your 
personal requirements with the help of manual selection (will be saved). 

 The Real-Time Protection section displays information on scanned files, as well as 
other statistical data, which can be reset at any time, and enables access to the 
report file. More detailed information on the last virus or unwanted program detected 
can be obtained practically "at the push of a button". 

 INTERNET PROTECTION: In this section you will find the components to protect your 
computer system against viruses and malware from the Internet, and against 
unauthorized network access. 

 The FireWall section enables you to configure the basic settings for the FireWall. In 
addition, the current data transfer rate and all active applications using a network 
connection are displayed. 

 The Web Protection section displays information on scanned URLs and detected 
viruses, as well as other statistical data, which can be reset at any time and enables 
access to the report file. More detailed information on the last virus or unwanted 
program detected can be obtained practically "at the push of a button". 

 CHILD PROTECTION:  In this section you will find the components to ensure a safe 
Internet experience for your children. 

 Social Networks: This section redirects you to the Social Network Protection 
application. Social Network Protection informs parents of their children's activities 
online. It checks their social network accounts for comments, photos etc. that may 
influence the child's reputation in a negative way or may indicate that the child is in 
danger. 

 MOBILE PROTECTION: From this section you will be redirected to the online access 
for Android devices. 



 Control Center 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 80 

 Avira Android Security manages all your android-based devices. 

 ADMINISTRATION: In this section you will find tools for isolating and managing 
suspicious or infected files, and for planning recurring tasks. 

 The Quarantine section contains the so-called quarantine manager. This is the 
central point for files already placed in quarantine or for suspect files that you would 
like to place in quarantine. It is also possible to send a selected file to the Avira 
Malware Research Center by email. 

 The Scheduler section enables you to configure scheduled scanning and update 
jobsand to adapt or delete existing jobs. 

 The Reports section enables you to view the results of actions performed. 

 The Events section enables you to view events generated by certain program 
modules. 

Buttons and links 

The following buttons and links may be available. 

Button / link Shortcut Description 

 

F8 This button or link is used to access the corresponding 
configuration dialog for the section. 

  F1 This button or link opens the corresponding online help 
topic for the section. 

 

  This link opens the Experts Market website where you 
can ask for help or offer your help to other users. 

7.2 File 

7.2.1 Exit 

The menu item Exit in the File menu, closes the Control Center. 

7.3 View 

7.3.1 Status 

The start screen of the Control Center, the Status section, enables you to see at a glance 
whether your computer system is protected and which Avira modules are active. The 
Status window also provides information about the last update performed. You can also 

see whether you own a valid license. 
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 PC Protection: Real-Time Protection, Last scan, Last update, Upgrade 

 Internet Protection: Web Protection, FireWall, Experts Market 

Note 
The User Account Control (UAC) will ask for your permission to enable or 
disable the Real-Time Protection and Web Protection services in operating 
systems as of Windows Vista. 

PC Protection 

Information on the current status of the service and protective functions, locally protecting 

your computer against viruses and malware, is displayed in this section. 

Real-Time Protection 

Information on the current status of the Real-Time Protection is displayed in this field. 

You may enable or disable the Real-Time Protection by clicking the ON/OFF button. 
Further options for the Real-Time Protection can be accessed by clicking Real-Time 
Protection in the navigation bar. At first you get information on the status of last found 

malware and infected files. Click Configuration to define further settings. 

 Configuration: Go to the Configuration to define the settings for the Real-Time 
Protection components. 

 
The following possibilities are available:  
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Icon Status Option Description 

 

Activated Deactivate The Real-Time Protection service is active, i.e. 
your system is continually monitored for viruses 

and unwanted programs. 

Note 
You can disable the Real-Time 
Protection service. However, please 
note that if Real-Time Protection is 
disabled you are no longer protected 

from viruses and unwanted programs. 
All files can pass through the system 
unnoticed and possibly cause 

damage. 

 

Deactivated Activate The Real-Time Protection service is disabled, 
i.e. the service is loaded but is not active. 

Warning 
No scan is performed for viruses and 
unwanted programs. All files can pass 
through the system unnoticed. You 
are not protected against viruses and 

unwanted programs. 

Note 
In order to be protected against 
viruses and unwanted programs 
again, please click the ON/OFF button 
next to Real-Time Protection in the 
PC Protection area. 
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Service 
stopped 

Start 
service 

The Real-Time Protection service is stopped. 

Warning 
No scan is performed for viruses and 
unwanted programs. All files can pass 
through the system unnoticed. You 
are not protected against viruses and 

unwanted programs. 

Note 

In order to be protected against 
viruses and unwanted programs 
again, please click the ON/OFF button 
next to Real-Time Protection in the 
PC Protection area. The current 

status should be displayed in green 

color, meaning Activated. 

Unknown Help This status is displayed when an unknown error 
occurs. In this case, please get in touch with our 
Support. 

Last scan 

Information on the last system scan performed is displayed in this field. When a complete 
system check is performed, all the hard disks on your computer are thoroughly scanned. 
All scanning processes, with the exception of the integrity checking of system files, are 
employed: standard file scanning, checking the registry and boot sectors, scanning for 

rootkits, etc. 

The following details are displayed: 

 Date of last complete system scan 

The following possibilities are available: 
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System scan Option Description 

Not 

performed 
Scan 
system 

No complete system check has been executed since 
installation. 

Warning 
The status of the system is unchecked. There is the 
possibility that viruses or unwanted programs are to 

be found on your computer. 

Note 
To check your computer, please click on the Scan 

system link. 

Date of last 
system 
scan, e.g. 
09/18/2011 

Scan 

system 

You performed a complete system scan on the specified date. 

Note 
We recommend that you use the default scan job 
Complete system scan. Use the Scheduler to 

enable the Complete system scan job. 

Unknown Help This status is displayed when an unknown error occurs. In this 

case, please get in touch with our Support.  

Last update 

Information on the current status of the last update performed is displayed here. 

The following details are displayed: 

 Date of the last update 

  Click the button Open Configuration to define further settings for automatic 
updates. 

The following possibilities are available: 
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Icon Status Option Description 

 

Date of last 
update, 
e.g. 
07/18/2011 

Start 
update 

The program has been updated during the last 
24 hours. 

Note 
You can update your Avira product to 
the latest version via the Start update 

button. 

 

Date of last 
update, 
e.g. 

07/18/2011 

Start 
update 

24 hours have already passed since the update 
but you are still within the update reminder cycle 
you chose. This depends on the setting in the 
configuration. 

Note 
You can update your Avira product to 
the latest version via the Start update 

button. 

 

Not 

performed 
Start 
update 

Since installation no update has been performed 

-or- 

The update reminder cycle you chose has been 
exceeded (see Configuration) and no update has 
been performed 
-or- 
The virus definition file is older than the update 
reminder cycle you have selected (see 

Configuration). 

Note 
You can update your Avira product to 
the latest version via the Start update 

button. 

Not 
available 

If the license has expired, no updates can be 
performed. 
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Upgrade 

In this field you can buy the pay version of the Avira product. 

Internet Protection 

Information on the current status of the service protecting your computer against viruses 

and malware from the Internet, is displayed in this section. 

 FireWall: The service monitors the communication channels to and from your 
computer. 

 Web Protection: The service checks the data that is transmitted and loaded into your 
web browser while you are surfing the Internet (monitoring of ports 80, 8080, 3128). 

 Experts Market: By clicking the button Visit Avira Experts Market you will be 
redirected to the Experts Market online platform. There you can contact experts to help 

you with your computer troubles or offer your services as an expert. 

Other options for these processes can be accessed from a context menu by clicking the 

configuration icon next to the ON/OFF button.  

 Configure: Go to the Configuration to define settings for the process component. 

The following possibilities are available: Services 
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Icon Status Process 

status 

Option Meaning 

 

OK Activated Deactivate All services for Internet Protection 

are active. 

Note 
You can deactivate a 
service by clicking the 
ON/OFF button. Note, 
however, that you are 

no longer fully protected 
against viruses and 
malware once a service 

has been deactivated. 

 

Restricted Deactivated Activate A service is deactivated, i.e. the 
service has been started but is not 

active. 

Warning 
Your computer system 
is not being fully 
monitored. There is a 
possibility that viruses 
and unwanted programs 
can access your 

computer system. 

Note 
To activate the service, 
click the ON/OFF 
button. 
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Warning Service 
stopped 

Start 
service 

A service has been stopped 

Warning 
Your computer system 
is not being fully 
monitored. There is a 
possibility that viruses 
and unwanted programs 
can access your 

computer system. 

Note 
Click the ON/OFF 
button to start the 
service so that your 
computer system is 
monitored. The service 
is started and activated. 

Unknown Help This status is displayed when an 
unknown error occurs. In this case, 
please get in touch with our 

Support.  

 

7.3.2 System Scanner 

The System Scanner section enables you to easily configure and start a system scan. 
Predefined profiles enable a system scan with already adapted default options. In the 
same way it is possible to adapt the system scan for viruses and unwanted programs to 
your personal requirements with the help of manual selection.  

The display and handling of the editable profiles corresponds to that of the Windows 
Explorer. Every folder in the main directory corresponds to one profile. Folders to be 
scanned are selected or can be selected with a check mark in front of the folder to be 

scanned. 

 To change drives, double-click the required letter of the drive. 

 To select drives, you can click on the box in front of the drive icon. 

 You can navigate through the menu structure with the aid of the scroll bar and the scroll 
arrows. 
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Predefined profiles 

Predefined scan profiles are available if required. 

Note 
These profiles are read-only and cannot be altered or deleted. To adapt a 

profile to your requirements, select the folder Manual selection. 

Note 
The scanning options for the predefined profiles can be set in Configuration > 
System Scanner > Scan > Files. You can adapt these settings to your 
requirements. 

Local Drives 

All local drives on your system are scanned for viruses or unwanted programs. 

Local Hard Disks 

All local hard disks on your system are scanned for viruses or unwanted programs. 

Removable Drives 

All available removable drives of your system are scanned for viruses or unwanted 
programs. 

Windows System Directory 

The Windows system directory of your system is scanned for viruses or unwanted 
programs. 

Complete system scan 

All local hard disks on your computer are scanned for viruses or unwanted programs. 
During the scan, all scanning processes, with the exception of the integrity checking of 
system files, are employed: Standard scan of files, scanning of registry and boot 
sectors, scanning for rootkits, etc. (see System Scanner > Overview). The scanning 
processes are performed regardless of the scanner setting in the configuration under 

System Scanner > Scan: Other settings. 

Quick system scan 

The most important folders of your system (directories Windows, Programs, 
Documents and Settings\Local User, Documents and Settings\All Users) are scanned 

for viruses and unwanted programs. 

My Documents 

The default "My Documents" location of the logged-in user is scanned for viruses and 

unwanted programs. 



 Control Center 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 90 

Note 
Under Windows, "My Documents" is a directory in the profile of the user that is 

used as the default location for documents that have been saved. The default 
setting for the directory is C:\Documents and Settings\[user name]\My 

Documents. 

Active Processes 

All current processes are scanned for viruses or unwanted programs. 

Scan for Rootkits and active malware 

The computer is scanned for rootkits and active (running) malware programs. All 

running processes are checked. 

Note 
In interactive mode you have several ways of reacting to a detection. In 

automatic mode the detection is recorded in the report file. 

  

Note 

The rootkits scan is not available for Windows XP 64 bit ! 

  

7.3.3 Manual selection 

Select this drive if you want to adapt the scan to your individual requirements.  

7.3.4 Real-Time Protection 

The Real-Time Protection section displays information on scanned files, as well as other 
statistical data, and enables access to the report file. More detailed information on the last 

virus or unwanted program detected can be obtained practically "at the push of a button". 

Note 
If the Real-Time Protection service is not started, the button next to the module 
is displayed in yellow color. However, the report file of the Real-Time Protection 

can be displayed. 
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Toolbar 

Icon Description 

 

Display report file 

The report file of the Real-Time Protection is displayed. 

Displayed information 

Last file found 

Shows the name and location of the file last found by the Real-Time Protection. 

Last virus or unwanted program found 

Gives the name of the last virus or unwanted program found. 

Icon/link Description 

 

Click the icon or 
link to display 
detailed information 
about the virus or 
unwanted program 
if an Internet 
connection is 

present. 

Last file scanned 

Shows the name and path of the file last scanned by the Real-Time Protection. 

Statistics 

Number of files 

Shows the number of files scanned so far. 

Number of detections 

Shows the number of viruses and unwanted programs found so far. 

Number of suspicious files 

Displays the number of files reported by the heuristics. 
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Number of deleted files 

Shows the number of files deleted so far. 

Number of repaired files 

Shows the number of files repaired so far. 

Number of moved files 

Shows the number of files moved so far. 

Number of renamed files 

Shows the number of files renamed so far. 

7.3.5 FireWall 

Windows Firewall (as of Windows 7) 

Avira manages the Windows Firewall from the Control and Configuration Center. 

The FireWall section enables you to check the status of the Windows Firewall and restore 
the recommended settings by clicking the Fix problem button. 

7.3.6 Web Protection 

The Web Protection section shows information on scanned URLs, as well as other 
statistical data and enables access to the  

 

 

 

Avira Social Network Protection is a web-based application that monitors your children's 
activities online.  Its sole purpose is to help raise your and your children's awareness of all 
the dangers lurking on the internet and to prevent your children from suffering any harm. 
The Social Networks technology checks their social network accounts for comments, 
photos etc. that may influence your child's reputation in a negative way or may indicate 
that your child is in danger. It then alerts you of questionable friends and potentially 
harmful activities on your child’s social network account including  

 contact from strangers  

 cyberbullying 

  inappropriate content 

  revealing personal information  
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 careless, potentially reputation-damaging activities. 

Avira Social Network Protection can monitor the following social networks: 

 Facebook 

 MySpace 

 Twitter 

 Google+ 

 Formspring 

  

Note 
To enable monitoring of any of your children's accounts you will need either 
their approval or their username and password for the respective account. 

Further information: 
Creating a Social Network Protection account 
Logging into your Social Network Protection account 

7.3.7 Avira Android Security 

Avira Android Security app is not only focused on anti-theft measures that help you to get 
back your mobile device once you have misplaced it, or even worse: if it has been stolen. 
The application allows you to block incoming calls and SMS. Avira Android Security 

protects cell phones and smartphones running with Android operating system. 

Avira Android Security consists of two components: 

 The app itself, installed on your Android device 

 The Avira Android Web Console for registration and feature control 

Avira Android Security is a free of charge app that does not require a license. All major 
brands are supported by Avira Android Security as Samsung, HTC, LG and Motorola. 

You can find more information on our website: 

 www.avira.com/android 

7.3.8 Quarantine 

The Quarantine manager manages affected objects. Your Avira product can move 
affected objects to the quarantine directory in a special format. They can neither be 

executed nor opened. 

www.avira.com/android
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Note 
To move objects to the Quarantine manager, select the relevant option for 
quarantine in the Configuration under System Scanner - Scan > Action on 
detection if you are working in automatic mode. 

Alternatively you can select the relevant quarantine option in interactive mode. 

  

Toolbar, shortcuts and context menu 

Icon Shortcut Description 

 

F2 Rescan object(s) 

A selected object is scanned again for viruses and unwanted 
programs. The settings of the on-demand scan are used for this. 

 

Return Properties 

Opens a dialog box with more detailed information on the selected 
object. 

Note 
You may obtain detailed information also by double-

clicking an object. 
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(Windows 
Vista) 

F3 Restore object(s) 

A selected object is restored. Hereafter the object is placed in its 
original location. 

Warning 
Enormous damage in the system due to viruses and 
unwanted programs! 
If you restore files: ensure that only files that were able to 

be cleaned by another scan are restored. 

Note 
As of Windows Vista, you must have administrator rights 

to restore objects. 

 

F6 Restore object(s) to... 

A selected object can be restored at a location defined by you. If 
you select this option, the "Save as" dialog opens in which you can 

select the storage location. 

Warning 
Enormous damage in the system due to viruses and 
unwanted programs! 
If you restore files: ensure that only files that were able to 
be cleaned by another scan are restored. 
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Ins Add file to quarantine 

If you regard a file as suspicious, you can add it to the quarantine 
manager manually with this option. If appropriate upload the file to 
an Avira Malware Research Center web server for investigation 

using the Send object option. 

 

F4 Send object(s) 

The object is uploaded to an Avira Malware Research Center web 
server for investigation by the Avira Malware Research Center. 
When you click on the Send Object button, a dialog opens 

containing a form for entering your contact data. Enter all the 
required data. Select a type: Suspicious file or False positive. 
Click OK to upload the suspicious file. 

Note 
The size of the files you upload is limited to 20 MB 

uncompressed or 8 MB compressed. 

Note 
You can only upload one file at a time.  

 

Del Delete object(s) 

A selected object is deleted from the quarantine manager. The 
object cannot be restored. 

 

F7 Export all properties 

The properties of the highlighted quarantined object are exported in 
a text file. 

 

F10 Open quarantine directory 

Opens the directory INFECTED. 

Note 
You have the option of executing actions on multiple highlighted objects. 
To highlight multiple objects (objects in columns), hold down the control key or 
the shift key while selecting the objects in quarantine manager. Press Ctrl + A 
to select all the displayed objects. 
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When executing the action Display properties multiple objects cannot be 
selected. Multiple selections are not possible with the Send object action, as 

only one file can be uploaded at a time. 

Table 

Status 

An object placed in quarantine can have different statuses: 

Icon Description 

 

No virus or unwanted program was found, the object is "clean". 

 

A virus or unwanted program was found. 

 

If a suspect file was added to the quarantine manager with the option Add file, it has 

this warning icon. 

Type 

Designation Description 

File The object detected is a file. 

Detection 

Shows the name of the malware found. 

Heuristic findings are identified with the abbreviation HEUR/. 

Source 

Shows the path under which the object was found. 

Date/Time 

Shows the date and time of the detection. 

Detailed information 

File name 

Full path and file name of the object. 

Quarantined object 

File name of the quarantined object. 
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Restored 

YES/ NO 

YES: The selected object has been restored. 

NO: The selected object has not been restored. 

Uploaded to Avira 

YES/ NO 

YES: The object has already been uploaded to an Avira Malware Research Center 

web 

server for investigation by the Avira Malware Research Center. 

NO: The object has not yet been uploaded to an Avira Malware Research Center web 

server for investigation by the Avira Malware Research Center. 

Operating system 

Windows XP: The malware has been identified by an Avira desktop product. 

Scan engine 

Version number of scan engine 

Virus definition file 

Version number of the virus definition file 

Detection 

Name of the malware detected. 

Date/Time 

Date and time of the detection 

7.3.9 Scheduler 

The Scheduler gives you the option of creating scheduled scanning and update jobs , and 

adapting or deleting existing jobs. 

The following job is created by default after installation: 

 Scan job Quick System Scan (enabled by default): A weekly quick system scan is 
automatically performed. During the quick system scan, only important files and folders 
on your computer are scanned for viruses or unwanted programs. You can modify the 
job Quick System Scan, but it is recommended to create other scan jobs, that would 
better reflect your needs. 
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Toolbar, shortcuts and context menu 

Icon Shortcut Description 

 

Ins Insert new job 

Creates a new job. A wizard clearly guides you through the necessary 
settings. 

 

Return Properties 

Opens a dialog box with more information on the selected job. 

 

F2 Edit job 

Opens the wizard to create and alter a job. 

 

Del Delete job 

Deletes the selected jobs from the list. 

 

  Display report file 

The report file of the Scheduler is displayed. 

 

F3 Start job 

Start a marked job from the list. 

 

F4 Stop job 

Stops a started and marked job. 

Table 

Type of job 
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Icon Description 

 

The job is an update job. 

 

The job is a scan job. 

Name 

Name of the job. 

Action 

Indicates whether the job is a scan or an update. 

Frequency 

Indicates how often and when the job is started. 

Display mode 

The following display modes are available: 

Invisible: The job is performed in the background and is not visible. This applies to 

scanning jobs and update jobs. 

Minimize: The job window only displays a progress bar. 

Maximize: The job window is completely visible. 

Enabled 

The job is activated when you activate the check box. 

Note  
If the frequency of the job was set to Immediate, the job is started as soon as it 
is activated. This gives you the ability to restart the job if necessary. 

Status 

Displays the status of the job: 

Ready: The job is ready for execution. 

Running: The job has started and is being executed. 

Create jobs with the Scheduler 

The planning wizard supports you in planning, configuring and creating 

 a timed scan for viruses and unwanted programs 
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 a timed update via the Internet 

For both types of jobs you must enter 

 the name and the description of the job 

 when the job should be started 

 how often the job should be performed 

 the display mode of the job 

Frequency of the job 

Frequency of 

the job 

Description 

Immediately Job is started immediately after ending 
the planning wizard. 

Daily Job is started daily at a certain time, e.g. 
22:00. 

Weekly Job is started weekly on a certain day or 
on several weekdays at a certain time, 

e.g. Tuesday and Friday, 16:26. 

Interval Job is performed at specific intervals, 

e.g. every 24 hours. 

Single Job is performed once at a defined time, 
e.g. on 10.04.04 at 10:04. 

Start time of the job 

You can define a weekday, date, time or interval for the job start time. This is not displayed 
if you have entered Immediately as the start time. 

Depending on the job type, there are various additional options 

Repeat job if the time has already expired 

Past jobs are performed that could not be performed at the required time, for example 
because the computer was switched off. 
This option can be selected both with an update job and with a scan job that is to be 

performed daily, weekly, at intervals or once. 
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Shut down computer if job is done 

The computer is shut down when the job is finished. Scan jobs can be displayed 
minimized and maximized. 

Note 

With a scan job, it is possible to select pre-defined profiles. 

7.3.10 Reports 

The Reports section enables you to access the results of actions performed by the 

program. 

Toolbar, shortcuts and context menu 

Icon Shortcut Description 

 

Return Display report 

Opens a window in which the result of the selected action is displayed. For 
example the result of a scan. 

 

F3 Display report file 

Displays the report file of the selected report. 

 

F4 Print report file 

Opens the Windows print dialog to print the report file. 

 

Del Delete report(s) 

Deletes the selected report and the relevant report file. 

Table 

Status 
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Icon Description 

 

Action scan: Finished successfully without detecting virus. 

 

Action scan: Virus detected or finished unsuccessfully. 

 

Action update: Successfully completed. 

 

Action update: Not successfully completed. 

 Action 

 Shows the action performed. 

 Result 

 Shows the result of the action. 

 Date/Time 

 Shows the date and time when the report was created. 

7.3.11 Contents of a report for a scan 

 Date of the scan: 

 The date of the scan. 

 Start time of the scan: 

 The start time of the scan in hh:mm. 

 Scanning time required: 

 The duration of the scan in mm:ss format. 

 Scan status: 

 Shows if the scan was completed. 

 Last detection: 

 Name of the last found virus or unwanted program. 

 Scanned directories: 

 Total number of scanned directories. 

 Scanned files: 

 Total number of scanned files. 

 Scanned archives: 

 Number of scanned archives. 

 Hidden objects: 
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 Total number of hidden objects detected 

 Detections: 

 Total number of viruses and unwanted programs detected. 

 Suspicious: 

 Number of suspicious files. 

 Warnings: 

 Number of alerts about detected viruses. 

 Information: 

 Number of information items issued, for example further information that may arise 
during a scan. 

 Repaired: 

 Total number of repaired files 

 Quarantine: 

 Total number of files placed in quarantine. 

 Renamed: 

 Total number of renamed files. 

 Deleted: 

 Total number of deleted files. 

 Wiped: 

 Total number of overwritten files. 

Note 
Rootkits have the ability to hide processes and objects, such as registry entries 
or files. However not every hidden object is necessarily proof of the existence of 
a rootkit. Hidden objects can also be harmless objects. If a scan detects hidden 
objects but does not issue a virus detection alert, you should use the report to 
determine which object is referred to and obtain more information about the 

detected object. 

7.3.12 Events 

Events that have been generated by the various program components are displayed under 

Events. 

The events are stored in a database. You can limit the size of the event database or 
disable the restriction on the database size (see ). Only the events of the last 30 days are 
saved in the default setting. The event display is automatically updated when you select 

the Events section. 
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Note 
The display is not automatically updated when the section is selected if there 
are more than 20,000 events stored in the event database. In this case, press 
F5 to update the event viewer. 

Toolbar, shortcuts and context menu 

Icon Shortcut Description 

 

Return Show selected event 

Opens a window in which the result of the selected action is displayed. For 
example the result of a scan. 

 

F3 Export selected event(s) 

Exports selected events. 

 

Del Delete selected event(s) 

Deletes the selected event. 

Note 
You have the option of carrying out actions on a number of selected events. To 
select a number of events, press and hold the Ctrl key or the Shift key (selects 
consecutive events) as you select the events you want. To select all displayed 
events, press Ctrl + A. 
In the case of the Show selected event action, performing the action on a 
multiple selection of objects is not possible. 

Modules 

The events of the following modules (here in alphabetical order) can be displayed by the 

event viewer: 

Module's name 

Helper Service 

Real-Time Protection 
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Scheduler 

System Scanner 

Updater 

Web Protection 

By checking the box All you can display the events of all available modules. To display 

only the events of a specific module, please check the box next to the required module. 

Filter 

The following event classification can be displayed by the event viewer. 

Icon Description 

 

Information 

 

Warning 

 

Error 

 

Detection 

By checking the box Filter  you can display all events. To display only certain events, 

please check the box next to the required event. 

Table 

The event list contains the following information: 

 Icon 

 The icon of the event classification. 

 Type 

 A classification of the event severity: Information, Warning, Error, Detection. 

 Module 

 The module that has logged the event. For example the Real-Time Protection 
module that made a detection. 

 Action 
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 Event description of the respective module. 

 Date/Time 

 The date and the local time the event occurred. 

7.3.13 Refresh 

Updates the view of the opened section. 

7.4 Extras 

7.4.1 Boot records scan 

You can also scan the boot sectors of the drives of your workstation with a system scan. 
This is recommended, for example, when a system scan detects a virus and you want to 

make sure that the boot sectors are not affected. 

It is possible to select more than one boot sector by keeping the Shift key pressed and 
selecting the required drives with the mouse. 

Note 
You can have the boot sectors automatically scanned with a system scan (see 
Scan boot sectors of selected drives). 

  

Note 
As of Windows Vista, you must have administrator rights to scan the boot 

sectors. 

7.4.2 Detection list 

This function lists the names of the viruses and unwanted programs recognized by your 

Avira product. A convenient search function for the names is integrated. 

Search detection list 

Enter a search word or character sequence in the Search for: box. 

Search for character sequence within a name 

You can enter a consecutive sequence of letters or characters here on the keyboard 
and the marker moves to the first point in the list of names that includes this sequence 
– even in the middle of a name (example: "raxa" finds "Abraxas"). 
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Search from the first character of a name 

You can enter the initial letter and the following characters here on the keyboard and 
the marker scrolls alphabetically in the list of names (example: "Ra" finds "Rabbit"). 

If the name or sequence of characters searched for is available, the position found is 

marked in the list. 

Search forwards 

Starts the search forwards in alphabetical order. 

Search backwards 

Starts the search backwards in alphabetical order. 

First match 

Moves in the list to the first entry found. 

Entries of the detection list 

Under this title is a list of the names of viruses or unwanted programs that can be 
recognized. Most entries in this list can also be removed with your Avira product. They 
are listed in alphabetical order (first special characters and numbers, then the letters). 
Use the scroll bar to scroll up or down in the list. 

7.4.3 Configuration 

The menu item Configuration in the Extras menu opens the Configuration. 

7.5 Update 

7.5.1 Start update... 

The menu item Start update... in the Update menu starts an immediate update. The virus 

definition file and scan engine are updated.  

7.5.2 Manual update... 

The menu item Manual update... in the Update menu opens a dialog box to select and 
load a VDF/search engine update package. The update package can be downloaded from 
the manufacturer's website and contains the current virus definition file and scan engine:  

http://www.avira.com 

Note 
As of Windows Vista, you must have administrator rights to perform a manual 

update. 

http://www.avira.com/
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7.6 Help 

7.6.1 Topics 

The menu item Topics in the Help menu opens the list of contents of the online help. 

7.6.2 Help me 

If an Internet connection is active, the Help me item in the Help menu opens the relevant 
Support page for your product on the Avira website. There you can read the answers to 

frequently asked questions, consult the knowledgebase and contact Avira Support. 

7.6.3 Forum 

If an Internet connection is active, the Forum menu command in the Help menu opens a 
web page giving you access to the Avira Forum. 

7.6.4 Download manual 

When an Internet connection is active, the menu command  Download Manual in the 
Help menu opens the download page of your Avira product. This is where you will find the 
link for downloading the current version of the manual for your Avira product. 

7.6.5 License management 

The menu item License management in the Help menu opens the license wizard. This 

assistant helps you to license or activate your Avira product in an easy way. 

Activate product 

Activate this option if you already have an activation code and have not yet activated your 
Avira product. During the product activation, you are registered as a customer and your 
Avira product is activated with your license. You have received the activation code from us 

either by email or it has been printed on the product packaging. 

Note 
The activation of the program can be performed repeatedly with a valid 

activation code, should this be required by a new installation of the system. 

  

Note 
For product activation, the program uses the HTTP protocol and port 80 (web 
communication) as well as encryption protocol SSL and port 443 to 
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communicate with the Avira servers. If you are using a firewall, please ensure 
that the required connections and/or incoming or outgoing data are not blocked 

by the firewall. 

  

Note 
You have the option of launching a product upgrade for a product from the Avira 
desktop product family (see Product information > Licensing and Upgrade). 
Enter the activation code for the product you want to upgrade in the Activation 

code input box. If an upgrade is available, the product is automatically installed. 

Purchase/Extend license 

This option is displayed if your license is still valid, has lapsed or, if you just have an 
evaluation license. Use this option to extend your product license or to buy a full version 
license. This requires an active Internet connection. Select the Purchase/Extend License 
option and click Next. Your Internet browser will open and you will reach the Avira online 
shop, where you can purchase a license. 

Valid license file 

You can load a valid license file via the license file link. 

During product activation with a valid activation code the license key is generated, saved 
in the program directory of your Avira product and loaded. Use this option if you have 

already activated a product. 

Proxy settings ... 

A dialog box will open when you click this button. If and when required, you can set here 

that you want to establish the Internet connection for product activation by a proxy server. 

7.6.6 Recommend product 

If an Internet connection is active, the Recommend product item in the Help menu opens 
a website for Avira customers. Use this page to recommend your Avira product and take 

advantage of Avira discounts. 

7.6.7 Send feedback 

When an Internet connection is active, the menu command Send feedback in the Help 
menu opens an feedback page for Avira products. Here you will find a product evaluation 
form that you can send to Avira with your assessments of product quality and other 
suggestions. 
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7.6.8 Show notifier again 

The menu command Show notifier again in the Help menu, lets you access the notifier of 

your Avira product. The notifier keeps you informed of the latest malware protection offers. 

7.6.9 About Avira Free Antivirus 

 General 

 Addresses and information about your Avira product. 

 Version information 

 Version information for files in the Avira product package. 

 License information 

 License data for the current license and links to the online shop (buying or extending 
a license). 

Note 
You can save the license data in the cache. Right click on the License data 

area. A context menu opens. In the context menu, click on the menu command 
Copy to clipboard. Your license data is now saved to the clipboard and can be 
added to emails, forms or documents via the Windows Add command. 

7.7 Experts Market 

7.7.1 Experts Market Overview 

Experts Market is a database that on one hand offers users to contact experts who are 
able to help them with their computer troubles and on the other hand enables experts to be 
easy-to-reach for those who need their help. 

In the following chapters you can find information on 

Ask for help 
Offering help 

7.7.2 Ask for help 

We always aim to design our product as comprehensible and user-friendly as possible. 
However, at times issues might arise where you are not sure how you should deal with 
them and would appreciate the help of an expert. Using Avira Free Antivirus you can 
access a database of individuals and organizations offering help in resolving your 

computer and software related problems. 

  Start Avira Free Antivirus. 
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 Click Visit the Avira Experts Market. 

  You are redirected to the Avira Experts Market website. 

  Click Find an expert. 

  You are redirected to the expert database where you can carry out a search 
according to your needs. 

The information displayed for each expert includes the following: 

 Profile Picture 

 Expert Name 

 City 

 Country 

 Availability 

 Description 

 User Rating 

 Users Helped 

 Expertise 

 Pricing information 

The experts can be sorted by User Rating or the number of Users Helped.  

  To get in touch with an expert on the spot, click Chat now.  

  A chat window opens allowing you to negotiate with your expert on how to 
proceed.   

  If the chosen expert is offline or busy, click Send message .  

  An email form opens allowing you to send an email to the expert. 

7.7.3 Offering help 

If you are a very experienced user, computer problems do not pose any problems to you 
and you would like to offer your help to other Avira users, you can register as an expert. 

Individuals as well as companies can register as an expert. 

  Start Avira Free Antivirus. 

 Click Visit the Avira Experts Market. 

  You are redirected to the Avira Experts Market website. 

  Click Learn more. 

  A registration form will be displayed.  

  Fill in the required information and click Register. 
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  A confirmation message is displayed and an email including an activation link is 
sent to your email address. 

  Click the activation link. 

  A website displaying the terms and conditions is shown. 

  Set a password for your Expert account and click Activate. 

 When the confirmation message is displayed, click Take me to Experts Portal.  

 You can now start helping other users. 

The information required for your registration includes the following: 

 Expert  

 Title 

 First Name 

 Last Name 

 Email Address 

 Street 

 Zip Code 

 Country 

You may also enter information regarding: 

 State 

 Telephone Number 

 Fax Number 

 Company Name 

 Commercial Registration Number 

 VAT-ID 

 Website 
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8. Child Protection 

Use Avira's CHILD PROTECTION features, to ensure a safe Internet experience for your 

children or other persons using your computer. 

 With the Social Networks feature, you can monitor your children's activities online. The 
Social Networks technology checks their social network accounts for comments, photos 
etc. that may influence your child's reputation in a negative way or may indicate that 
your child is in danger. 

Related topics: 

 Social Networks 

8.1 Social Networks 

This chapter contains comprehensive information on 

Creating a Social Network Protection account 
Logging in to your Social Network Protection account  

8.1.1 Creating a Social Network Protection account 

  Make sure that your computer is connected to the internet. 

 Click Control Center > View > Child Protection > Social Networks. 

 Click Get Started Now. 

  The web browser opens displaying the Avira Social Network Protection website. 

  If you have a Facebook account, you can now log in to Avira Social Network 
Protection by clicking the Facebook logo. 

-OR- 

  If you do not have a Facebook account, enter your first name, your last name, your 
email address and a password in the required fields and click Get Started. 

Note 

From now on your email address will serve as your username. 

8.1.2 Logging in to an existing Social Network Protection account 

  Make sure that your computer is connected to the internet. 

  Click Control Center > View > Child Protection > Social Networks. 
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 Click Log in. 

  If you have saved the cookie on your system, the web browser opens displaying 
your Avira Social Network Protection dashboard. 

-OR- 

  If your web browser does not accept cookies or removes them every time your 
web browser is closed, you can either log in by clicking on the Facebook logo or 
by entering your username and password. 
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9. Mobile Protection 

Avira does not only protect your computer system from malware and viruses but also 
protects your smartphone, running with Android operating system, from loss and theft. 
Using Avira Android Security you can also block unwanted calls or SMS. Simply add 
phone numbers from call log, SMS log and your list of contacts to the blacklist, or create 

manually a contact you want to block. 

You can find more information on our website: 

 www.avira.com/android 

www.avira.com/android
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10. Configuration 

 

 Overview of configuration options 

 Buttons 

10.1 Overview of configuration options 

The following configuration options are available: 

 System Scanner: Configuration of a system scan (on-demand) 

 Scan options 

 Action on detection  

 Archive scan options 

 System scan exceptions 

 System scan heuristics 

 Report function setting 

 Real-Time Protection: Configuration of a realtime scan (on-access) 

 Scan options 

 Action on detection  

 Further actions 

 On-access scan exceptions 

 On-access scan heuristics 

 Report function setting 

 Update: Configuration of the update settings, set-up of product updates 

 Download via web server 

 Proxy settings 

 Web Protection: Configuration of Web Protection 

 Scan options, enabling and disabling the Web Protection 

 Action on detection 

 Blocked access: Unwanted file types and MIME types 

 Web Protection scan exceptions: URLs, file types, MIME types 

 Web Protection heuristics 

 Report function setting 

 General: 

 Threat categories for System Scanner and Real-Time Protection 

 Application filter: Block or allow applications 
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 Password protection for access to the Control Center and the Configuration 

 Security: block autostart function, complete system scan status display, product 
protection, protect Windows hosts file  

 WMI: Enable WMI support 

 Event log configuration 

 Configuration of report functions 

 Setting of directories used 

 Configuration of acoustic alerts when malware is detected 

10.1.1 Buttons 

Button Description 

Default 

values 

All settings of the configuration are restored to default values. All amendments and custom 

entries are lost when default settings are restored. 

OK All the settings made are saved. The configuration is closed. The User Account Control (UAC) 

will ask for your permission to apply changes in operating systems as of Windows Vista. 

Cancel The configuration is closed without saving your settings in the configuration. 

Apply All the settings made are saved. The User Account Control (UAC) will ask for your permission 

to apply changes in operating systems as of Windows Vista. 

10.2 System Scanner 

The System Scanner section of configuration is responsible for the configuration of the 
on-demand scan. 

10.2.1 Scan 

You can define the behavior of the on-demand scan routine. If you select certain 

directories to be scanned, depending on the configuration, the System Scanner scans: 

 with a certain scanning priority, 

 also boot sectors and main memory, 

 all or selected files in the directory. 

Files 

The System Scanner can use a filter to scan only those files with a certain extension 
(type). 
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All files 

If this option is enabled, all files are scanned for viruses or unwanted programs, 
irrespective of their content and file extension. The filter is not used. 

Note 

If All files is enabled, the button File extensions cannot be selected. 

Use smart extensions 

If this option is enabled, the selection of the files scanned for viruses or unwanted 
programs is automatically chosen by the program. This means that your Avira program 
decides whether the files are scanned or not based on their content. This procedure is 

somewhat slower than Use file extension list, but more secure, since not only on the 
basis of the file extension is scanned. This option is enabled as the default setting and 

is recommended. 

Note 
If Use smart extensions is enabled, the button File extensions cannot be 
selected. 

Use file extension list 

If this option is enabled, only files with a specified extension are scanned. All file types 
that may contain viruses and unwanted programs are preset. The list can be edited 
manually via the button "File extension". 

Note 
If this option is enabled and you have deleted all entries from the list with file 
extensions, this is indicated with the text "No file extensions" under the button 

File extensions. 

File extensions 

With the aid of this button, a dialog box is opened in which all file extensions are 
displayed that are scanned in "Use file extension list" mode. Default entries are set 
for the extensions, but entries can be added or deleted. 

Note 

Please note that the default list may vary from version to version. 

Additional settings 
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Scan boot sectors of selected drives 

If this option is enabled, the System Scanner scans the boot sectors of the drives 
selected for the system scan. This option is enabled as the default setting. 

Scan master boot sectors 

If this option is enabled, the System Scanner scans the master boot sectors of the 
hard disk(s) used in the system. 

Ignore offline files 

If this option is enabled, the direct scan ignores so-called offline files completely during 
a scan. This means that these files are not scanned for viruses and unwanted 
programs. Offline files are files that were physically moved by a so-called Hierarchical 

Storage Management System (HSMS) from the hard disk onto a tape, for example. 
This option is enabled as the default setting. 

Integrity checking of system files 

When this option is enabled, the most important Windows system files are subjected to 
a particularly secure check for changes by malware during every on-demand scan. If 
an amended file is detected, this is reported as suspect. This function uses a lot of 

computer capacity. That is why the option is disabled as the default setting. 

Note 
This option is only available with Windows Vista and higher. 

  

Note 
This option should not be used if you are using third-party tools that modify 
system files and adapt the boot or start screen to your own requirements. 

Examples of such tools are skinpacks, TuneUp utilities or Vista Customization. 

Optimized scan 

When the option is enabled, the processor capacity is optimally utilized during a 
System Scanner scan. For performance reasons, an optimized scan is only logged on 

standard level. 

Note 
This option is only available on multi-processor systems.  
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Follow symbolic links 

If this option is enabled, System Scanner performs a scan that follows all symbolic 
links in the scan profile or selected directory and scans the linked files for viruses and 

malware. 

Note 
The option does not include any shortcuts, but refers exclusively to symbolic 
links (generated by mklink.exe) or Junction Points (generated by junction.exe) 

that are transparent in the file system. 

Search for Rootkits before scan 

If this option is enabled and a scan is started, the System Scanner scans the Windows 
system directory for active rootkits in a so-called shortcut. This process does not scan 
your computer for active rootkits as comprehensively as the scan profile "Scan for 
rootkits", but it is significantly quicker to perform. This option only changes the 
settings of profiles created by you. 

Note 

The rootkits scan is not available for Windows XP 64 bit  

  

Scan Registry 

If this option is enabled, the Registry is scanned for references to malware. This option 
only changes the settings of profiles created by you. 

Ignore files and paths on network drives 

 If this option is enabled, network drives connected to the computer are excluded from 
the on-demand scan. This option is recommended when the servers or other 
workstations are themselves protected with anti-virus software. This option is disabled 

as the default setting. 

Scan process 

Allow stopping the Scanner 

If this option is enabled, the scan for viruses or unwanted programs can be terminated 
at any time with the button "Stop" in the "Luke Filewalker" window. If you have 
disabled this setting, the Stop button in the "Luke Filewalker" window has a gray 
background. Premature ending of a scan process is thus not possible! This option is 

enabled as the default setting. 
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Scanner priority 

With the on-demand scan, the System Scanner distinguishes between priority levels. 
This is only effective if several processes are running simultaneously on the 

workstation. The selection affects the scanning speed. 

low 

The System Scanner is only allocated processor time by the operating system, if no 
other process requires computation time, i.e. as long as only the System Scanner is 
running, the speed is maximum. All in all, work with other programs is optimal: The 
computer responds more quickly if other programs require computation time while the 

System Scanner continues running in the background. 

medium 

The System Scanner is executed with normal priority. All processes are allocated the 
same amount of processor time by the operating system. This option is enabled as the 
default setting and is recommended. Under certain circumstances, work with other 
applications may be affected. 

high 

The System Scanner has the highest priority. Simultaneous work with other 
applications is almost impossible. However, the System Scanner completes its scan at 

maximum speed. 

Action on detection 

You can define the actions to be performed by System Scanner when a virus or unwanted 

program is detected. 

Interactive 

If this option is enabled, the results of the System Scanner scan are displayed in a 
dialog box. When carrying out a scan with the System Scanner, you will receive an 
alert with a list of the affected files at the end of the scan. You can use the content-
sensitive menu to select an action to be executed for the various infected files. You 

can execute the standard actions for all infected files or cancel the System Scanner. 

Note 
The action Quarantine is preselected by default in the System Scanner 

notification. Further actions can be selected via a context menu. 

Automatic 

If this option is enabled, no dialog box in case of a virus detection appears. The 
System Scanner reacts according to the settings you predefine in this section as 

primary and secondary action. 
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Copy file to quarantine before action 

If this option is enabled, the System Scanner creates a backup copy before carrying 
out the requested primary or secondary action. The back-up copy is saved in 
Quarantine, where the file can be restored if it is of informative value. You can also 

send the backup copy to the Avira Malware Research Center for further investigation. 

Primary action 

Primary action is the action performed when the System Scanner finds a virus or an 
unwanted program. If the option "Repair" is selected but the affected file cannot be 
repaired, the action selected under "Secondary action" is performed. 

Note 

The option Secondary action can only be selected if the setting Repair was 

selected under Primary action. 

Repair 

If this option is enabled, the System Scanner repairs affected files automatically. If the 
System Scanner cannot repair an affected file, it carries out the action selected under 

Secondary action. 

Note 
An automatic repair is recommended, but means that the System Scanner 

modifies files on the workstation. 

Rename 

If this option is enabled, the System Scanner renames the file. Direct access to these 
files (e.g. with double-click) is therefore no longer possible. Files can later be repaired 

and given their original names again. 

Quarantine 

If this option is enabled, the System Scanner moves the file to the quarantine. These 
files can later be repaired or - if necessary - sent to the Avira Malware Research 

Center. 

Delete 

If this option is enabled, the file is deleted.  

Ignore 

If this option is enabled, access to the file is allowed and the file is left as it is. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 
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Secondary action 

The option "Secondary action" can only be selected if the setting Repair was 
selected under "Primary action". With this option it can now be decided what is to be 

done with the affected file if it cannot be repaired. 

Rename 

If this option is enabled, the System Scanner renames the file. Direct access to these 
files (e.g. with double-click) is therefore no longer possible. Files can later be repaired 

and given their original names again. 

Quarantine 

If this option is enabled, the System Scanner moves the file to Quarantine. These files 
can later be repaired or - if necessary - sent to the Avira Malware Research Center. 

Delete 

If this option is enabled, the file is deleted.  

Ignore 

If this option is enabled, access to the file is allowed and the file is left as it is. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 

Note 
If you have selected Delete as the primary or secondary action, you should note 
the following: In the case of heuristic hits, the affected files are not deleted, but 

are instead moved to quarantine. 

Archives 

When scanning archives, the System Scanner uses a recursive scan: Archives in archives 
are also unpacked and scanned for viruses and unwanted programs. The files are 

scanned, decompressed and scanned again. 

Scan archives 

If this option is enabled, the selected archives in the archive list are scanned. This 

option is enabled as the default setting. 

All archive types 

If this option is enabled, all archive types in the archive list are selected and scanned. 
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Smart Extensions 

If this option is enabled, the System Scanner detects whether a file is a packed file 
format (archive), even if the file extension differs from the usual extensions, and scans 
the archive. However every file must be opened for this, which reduces the scanning 
speed. Example: If a *.zip archive has the file extension *.xyz, the System Scanner 
also unpacks this archive and scans it. This option is enabled as the default setting. 

Note 

Only those archive types marked in the archive list are supported. 

Limit recursion depth 

Unpacking and scanning recursive archives can require a great deal of computer time 
and resources. If this option is enabled, you limit the depth of the scan in multi-packed 
archives to a certain number of packing levels (maximum recursion depth). This saves 

time and computer resources. 

Note 
In order to find a virus or an unwanted program in an archive, the System 
Scanner must scan up to the recursion level in which the virus or the unwanted 

program is located. 

Maximum recursion depth 

In order to enter the maximum recursion depth, the option Limit recursion depth must 
be enabled. 
You can either enter the requested recursion depth directly or by means of the right 
arrow key on the entry field. The permitted values are 1 to 99. The standard value is 

20 which is recommended. 

Default values 

The button restores the pre-defined values for scanning archives. 

Archives 

In this display area you can set which archives the System Scanner should scan. For 
this, you must select the relevant entries. 

Exceptions 

File objects to be omitted for the System Scanner 

The list in this window contains files and paths that should not be included by the System 
Scanner in the scan for viruses or unwanted programs. 
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Please enter as few exceptions as possible here and really only files that, for whatever 
reason, should not be included in a normal scan. We recommend that you always scan 

these files for viruses or unwanted programs before they are included in this list! 

Note 

The entries in the list must not result in more than 6000 characters in total. 

Warning 

These files are not included in a scan! 

Note 
The files included in this list are recorded in the report file. Please check the 
report file from time to time for unscanned files, as perhaps the reason you 
excluded a file here no longer exists. In this case you should remove the name 

of this file from this list again. 

Input box 

In this input box you can enter the name of the file object that is not included in the on-

demand scan. No file object is entered as the default setting. 

 

The button opens a window in which you can select the required file or the required 
path. 
When you have entered a file name with its complete path, only this file is not scanned 
for infection. If you have entered a file name without a path, all files with this name 
(irrespective of the path or drive) are not scanned. 

Add 

With this button, you can add the file object entered in the input box to the display 
window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 

  

Heuristic 

This configuration section contains the settings for the heuristic of the scan engine. 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
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extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 

trustworthy or not. 

Macrovirus heuristic 

Macrovirus heuristic 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 

option is enabled as the default setting and is recommended. 

Advanced Heuristic Analysis and Detection (AHeAD) 

Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 
default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 

10.2.2 Report 

The System Scanner has a comprehensive reporting function. You thus obtain precise 
information on the results of an on-demand scan. The report file contains all entries of the 
system as well as alerts and messages of the on-demand scan. 

Note 
To be able to establish what actions the System Scanner has performed, when 
viruses or unwanted programs have been detected, you should activate the 
report file in the configuration. 
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Reporting 

Off 

If this option is enabled, the System Scanner does not report the actions and results of 

the on-demand scan. 

Default 

When this option is activated, the System Scanner logs the path and names of the 
concerning files. In addition, the configuration for the current scan, version information 
and information on the licensee is written in the report file. 

Extended 

When this option is activated, the System Scanner logs alerts and tips in addition to 
the default information.  

Complete 

When this option is activated, the System Scanner also logs all scanned files. In 
addition, all files involved as well as alerts and tips are included in the report file. 

Note 
If you have to send us a report file at any time (for troubleshooting), please 

create this report file in this mode. 

10.3 Real-Time Protection 

The Real-Time Protection section of the configuration is responsible for the configuration 

of the on-access scan. 

10.3.1 Scan 

You will normally want to monitor your system constantly. To this end, use the Real-Time 
Protection (= on-access System Scanner). You can thus scan all files that are copied or 

opened on the computer "on the fly", for viruses and unwanted programs. 

Files 

The Real-Time Protection can use a filter to scan only those files with a certain extension 
(type). 

All files 

If this option is enabled, all files are scanned for viruses or unwanted programs, 

irrespective of their content and their file extension. 
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Note 

If All files is enabled, the File extensions button cannot be selected. 

Use smart extensions 

If this option is enabled, the selection of the files scanned for viruses or unwanted 
programs is automatically chosen by the program. This means that the program 
decides whether the files are scanned or not based on their content. This procedure is 
somewhat slower than Use file extension list, but more secure, since not only on the 
basis of the file extension is scanned. 

Note 

If Use smart extensions is enabled, the File extensions button cannot be 

selected. 

Use file extension list 

If this option is enabled, only files with a specified extension are scanned. All file types 
that may contain viruses and unwanted programs are preset. The list can be edited 
manually via the "File extensions" button. This option is enabled as the default 
setting and is recommended. 

Note 
If this option is enabled and you have deleted all entries from the list with file 
extensions, this is indicated with the text "No file extensions" under the File 
extensions button. 

File extensions 

With the aid of this button, a dialog box is opened in which all file extensions are 
displayed that are scanned in "Use file extension list" mode. Default entries are set 
for the extensions, but entries can be added or deleted. 

Note 

Please note that the file extension list may vary from version to version. 

Drives 

Monitor network drives 

If this option is enabled, files on network drives (mapped drives) such as server 

volumes, peer drives etc., are scanned. 
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Note 
In order not to reduce the performance of your computer too much, the option 

Monitor network drives should only be enabled in exceptional cases. 

Warning 
If this option is disabled, the network drives are not monitored. They are no 
longer protected against viruses or unwanted programs! 

Note 
When files are executed on network drives, they are scanned by the Real-Time 

Protection irrespective of the setting for the Monitor network drives option. In 
some cases files on network drives are scanned while being opened, even 
though the Monitor network drives option is disabled. Reason: These files are 
accessed with ‘Execute File’ rights. If you want to exclude these files or even 
executed files on network drives from scanning by the Real-Time Protection, 
enter the files in the list of file objects to be excluded (see: Real-Time Protection 

> Scan > Exceptions). 

Enable caching 

If this option is enabled, monitored files on network drives will be made available in the 
Real-Time Protection's cache. Monitoring of network drives without the caching 
function is more secure, but does not perform as well as the monitoring of network 

drives with caching. 

Archives 

Scan archives 

If this option is enabled, then archives will be scanned. Compressed files are scanned, 
then decompressed and scanned again. This option is deactivated by default. The 
archive scan is restricted by the recursion depth, the number of files to be scanned 
and the archive size. You can set the maximum recursion depth, the number of files to 

be scanned and the maximum archive size. 

Note 
This option is deactivated by default, since the process puts heavy demands on 
the computer's performance. It is generally recommended that archives be 

checked using an on-demand scan. 

Max. recursion depth 

When scanning archives, the Real-Time Protection uses a recursive scan: Archives in 
archives are also unpacked and scanned for viruses and unwanted programs. You can 
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define the recursion depth. The default value for the recursion depth is 1 and is 
recommended: all files that are directly located in the main archive are scanned. 

Max. number of files 

When scanning archives, you can restrict the scan to a maximum number of files in 
the archive. The default value for the maximum number of files to be scanned is 10 

and is recommended. 

Max. size (KB) 

When scanning archives, you can restrict the scan to a maximum archive size to be 
unpacked. The standard value of 1000 KB is recommended. 

Action on detection 

Use event log 

If this option is enabled, an entry is added to the Windows event log for every 
detection. The events can be called up in the Windows event viewer. This option is 
enabled as the default setting. 

Exceptions 

With these options you can configure exception objects for the Real-Time Protection (on-
access scan). The relevant objects are then not included in the on-access scan. The Real-
Time Protection can ignore file accesses to these objects during the on-access scan via 
the list of processes to be omitted. This is useful, for example, with databases or backup 

solutions. 

Please note the following when specifying processes and file objects to be omitted: The list 
is processed from top to bottom. The longer the list is, the more processor time is required 

for processing the list for each access. Therefore, keep the list as short as possible. 

Processes to be omitted by the Real-Time Protection 

All file accesses of processes in this list are excluded from monitoring by Real-Time 
Protection. 

Input box 

In this field, enter the name of the process that is to be ignored by the real-time scan. 

No process is entered as the default setting. 

The specified path and file name of the process should contain a maximum of 255 
characters. You can enter up to 128 processes. The entries in the list must not result 
in more than 6000 characters in total. 

When entering the process, Unicode symbols are accepted. You can therefore enter 

process or directory names containing special symbols. 

Drive information must be entered as follows: [Drive letter]:\ 

The colon symbol (:) is only used to specify drives. 
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When specifying the process, you can use the wildcards * (any number of characters) 
and ? (a single character). 

C:\Program Files\Application\application.exe 

C:\Program Files\Application\applicatio?.exe 

C:\Program Files\Application\applic*.exe 

C:\Program Files\Application\*.exe 

To avoid the process being excluded globally from monitoring by Real-Time 
Protection, specifications exclusively comprising the following characters are invalid: * 

(asterisk), ? (question mark), / (forward slash), \ (backslash), . (dot), : (colon). 

You have the option of excluding processes from monitoring by the Real-Time 

Protection without full path details. For example: application.exe 

This however only applies to processes where the executable files are located on hard 
disk drives. 

Full path details are required for processes where the executable files are located on 
connected drives, e.g. network drives. Please note the general information on the 

notation of Exceptions on connected network drives. 

Do not specify any exceptions for processes where the executable files are located on 
dynamic drives. Dynamic drives are used for removable disks, such as CDs, DVDs or 

USB sticks. 

Warning 
Please note that all file accesses done by processes recorded in the list are 

excluded from the scan for viruses and unwanted programs!  

 

The button opens a window in which you can select an executable file. 

Processes 

The "Processes" button opens the "Process selection" window in which the running 
processes are displayed. 

Add 

With this button, you can add the process entered in the input box to the display 

window. 

Delete 

With this button you can delete a selected process from the display window. 

File objects to be omitted by the Real-Time Protection 

All file accesses to objects in this list are excluded from monitoring by the Real-Time 
Protection. 
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Input box 

In this box you can enter the name of the file object that is not included in the on-
access scan. No file object is entered as the default setting. 

The entries in the list must have no more than 6000 characters in total. 

When specifying file objects to be omitted, you can use the wildcards* (any number of 
characters) and ? (a single character): Individual file extensions can also be excluded 

(including wildcards): 

C:\Directory\*.mdb 

*.mdb 

*.md? 

*.xls* 

C:\Directory\*.log 

Directory names must end with a backslash \ . 

If a directory is excluded, all its sub-directories are automatically also excluded. 

For each drive you can specify a maximum of 20 exceptions by entering the complete 

path (starting with the drive letter). For example: 

C:\Program Files\Application\Name.log 

The maximum number of exceptions without a complete path is 64. For example: 

*.log 

\computer1\C\directory1 

In case of dynamic drives that are mounted as a directory on another drive, the alias of 
the operating system for the integrated drive in the list of the exceptions has to be 

used, e.g.: 

\Device\HarddiskDmVolumes\PhysicalDmVolumes\BlockVolume1\ 

If you use the mount point itself, for example, C:\DynDrive, the dynamic drive will be 

scanned nonetheless. You can determine the alias of the operating system to be used 

from the Real-Time Protection report file. 

 

The button opens a window in which you can select the file object to be excluded. 

Add 

With this button, you can add the file object entered in the input box to the display 
window. 

Delete 

With this button you can delete a selected file object from the display window. 
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Please note the further information when specifying exceptions: 

In order to also exclude objects when they are accessed with short DOS file names (DOS 

name convention 8.3), the relevant short file name must also be entered in the list. 

A file name that contains wildcards may not be terminated with a backslash. For example: 
C:\Program Files\Application\applic*.exe\ 

This entry is not valid and not treated as an exception! 

Please note the following with regard to exceptions on connected network drives: If you 
use the drive letter of the connected network drive, the files and folders specified are NOT 
excluded from the Real-Time Protection scan. If the UNC path in the list of exceptions 
differs from the UNC path used to connect to the network drive (IP address specification in 
the list of exceptions – specification of computer name for connection to network drive), 
the specified folders and files are NOT excluded by the Real-Time Protection scan. Locate 
the relevant UNC path in the Real-Time Protection report file: 

\\<Computer name>\<Enable>\ - OR - \\<IP address>\<Enable>\ 

You can locate the path Real-Time Protection uses to scan for infected files in the Real-
Time Protection report file. Indicate exactly the same path in the list of exceptions. 
Proceed as follows: Set the protocol function of the Real-Time Protection to Complete in 
the configuration under Real-Time Protection > Report. Now access the files, folders, 
mounted drives or connected network drives with the activated Real-Time Protection. You 
can now read the path to be used from the Real-Time Protection report file. The report file 

can be accessed in the Control Center under Local protection > Real-Time Protection. 

Heuristic 

This configuration section contains the settings for the heuristic of the scan engine. 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 

trustworthy or not. 

Macrovirus heuristics 

Macrovirus heuristics 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 
option is enabled as the default setting and is recommended. 
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Advanced Heuristic Analysis and Detection (AHeAD) 

Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 

default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 

10.3.2 Report 

Real-Time Protection includes an extensive logging function to provide the user or 
administrator with exact notes about the type and manner of a detection. 

Reporting 

This group allows for the content of the report file to be determined. 

Off 

If this option is enabled, then Real-Time Protection does not create a log. 
It is recommended that you should turn off the logging function only in exceptional 

cases, such as if you are executing trials with multiple viruses or unwanted programs. 

Default 

If this option is enabled, Real-Time Protection records important information 
(concerning detections, alerts and errors) in the report file, with less important 

information ignored for improved clarity. This option is enabled as the default setting. 

Extended 

If this option is enabled, Real-Time Protection logs less important information to the 
report file as well. 

Complete 

If this option is enabled, Real-Time Protection logs all available information in the 
report file, including file size, file type, date, etc. 
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Limit report file 

Limit size to n MB 

If this option is enabled, the report file can be limited to a certain size. Permitted values 
are between 1 and 100 MB. Around 50 kilobytes of extra space are allowed when 
limiting the size of the report file to minimize the use of system resources. If the size of 
the log file exceeds the indicated size by more than 50 kilobytes, then old entries are 

deleted until the indicated size minus 50 kilobytes is reached. 

Backup report file before shortening 

If this option is enabled, the report file is backed up before shortening. 

Write configuration in report file 

If this option is enabled, the configuration of the on-access scan is recorded in the 

report file. 

Note 
If you have not specified any report file restriction, a new report file is 
automatically created when the report file reaches 100 MB. A backup of the old 
report file is created. Up to three backups of old report files are saved. The 

oldest backups are deleted first. 

10.4 Update 

In the Update section you can configure the automatic receiving of updates. You can 

specify various update intervals. 

Automatic update 

All n Day(s) / Hour(s) / Minute(s) 

In this box you can specify the interval at which the automatic update is performed. To 
change the update interval, highlight one of the time options in the box and change it 

using the arrow keys to the right of the input box. 

10.4.1 Web server 

Web server 

The update can be performed directly via a web server on the Internet. 

Web server connection 

Use existing connection (network) 

This setting is displayed if your connection is used via a network. 
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Use the following connection 

This setting is displayed if you define your connection individually. 

The Updater automatically detects which connection options are available. Connection 
options that are not available are grayed out and cannot be activated. A dial-up 
connection can be established manually via a phone book entry in Windows, for 

example. 

User 

Enter the user name of the selected account. 

Password 

Enter the password for this account. For security reasons, the actual characters you 

type in this space are replaced by asterisks (*). 

Note 
If you have forgotten an existing Internet account name or password, contact 
your Internet Service Provider. 

  

Note 
The automatic dial-up of the updater through so-called dial-up tools (e.g. 

SmartSurfer, Oleco, etc.) is currently not yet available. 

Terminate a dial-up connection that was set up for the update 

If this option is enabled, the dial-up connection made for the update is automatically 
interrupted again as soon as the download has been successfully performed. 

Note 
This option is only available under Windows XP. Under newer operating 
systems the dial-up connection opened for the update is always terminated as 
soon as the download has been performed. 

Proxy settings 

Proxy server 

Do not use a proxy server 

If this option is enabled, your connection to the web server is not established via a 

proxy server. 

Use proxy system settings 

When the option is enabled, the current Windows system settings are used for the 
connection to the web server via a proxy server. Configure the Windows system 



 Configuration 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 138 

settings to use a proxy server under Control panel > Internet options > 
Connections > LAN settings. You can also access the Internet options in the Extras 

menu in Internet Explorer. 

Warning 
If you are using a proxy server which requires authentication, enter all the 
required data under the option Use this proxy server. The Use proxy system 

settings option can only be used for proxy servers without authentication. 

Use this proxy server 

If your web server connection is set up via a proxy server, you can enter the relevant 

information here. 

Address 

Enter the computer name or IP address of the proxy server you want to use to connect 
to the web server. 

Port 

Please enter the port number of the proxy server you want to use to connect to the 
web server. 

Login name 

Enter a user name to log in on the proxy server. 

Login password 

Enter the relevant password for logging in on the proxy server here. For security 
reasons, the actual characters you type in this space are replaced by asterisks (*). 

Examples: 

Address: proxy.domain.com Port: 8080 

Address: 192.168.1.100 Port: 3128 

10.5 FireWall 

Avira Free Antivirus allows you to configure to manage the Windows Firewall (starting from 

Windows 7): 

 Avira FireWall 

 Windows Firewall 

10.5.1 Windows Firewall 

The FireWall section under Configuration > Internet Protection is responsible for 

configuration of the Windows Firewall, starting from Windows 7. 
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Network profiles 

Network profiles 

Windows Firewall blocks the unathorized access of programs and apps to your computer 

based on three network location profiles: 

 Private network: for home or office networks 

 Public network: for public places' networks 

 Domain network: for networks with a domain controller  

You can manage these profiles from the configuration of your Avira product under Internet 

protection > Windows Firewall > Network profiles. 

For further information about these network profiles, please visit the official Microsoft 
website. 

Warning 
Windows Firewall applies the same rules for all networks that belong to the 
same network location, this means that, if you allow to run a program or 
application, this program or application will also be granted access in all the 

networks that have the same profile. 

Private network 

Private network settings 

The private network settings manage the access other computers or devices in your home 
or office network have to your computer. These settings allow by default the users of the 

private network to see and access your computer. 

Enable 

If this option is enabled, Windows Firewall is activated and working through the Avira 

product. 

Block all incoming connections 

If this option is enabled, Windows Firewall will reject all unsolicited attempts to connect 

to your computer, including incoming connections from allowed applications. 

Notify me when a new app is blocked 

If this option is enabled, you will receive a notification every time that Windows Firewall 

blocks a new program or app. 
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Disable (not recommended) 

If this option is enabled, Windows Firewall is deactivated. This option is not 
recommended, it puts your computer at risk. 

Public network 

Public network settings 

The public network settings manage the access other computers or devices in public 
places' networks have to your computer. These settings do not allow, by default, the users 

of the public network to see and access your computer. 

Enable 

If this option is enabled, Windows Firewall is activated and working through the Avira 

product. 

Block all incoming connections 

If this option is enabled, Windows Firewall will reject all unsolicited attempts to connect 

to your computer, including incoming connections from allowed applications. 

Notify me when a new app is blocked 

If this option is enabled, you will receive a notification every time that Windows Firewall 

blocks a new program or app. 

Disable (not recommended) 

If this option is enabled, Windows Firewall is deactivated. This option is not 

recommended, it puts your computer at risk. 

Domain network 

Domain network settings 

The domain network settings manage the access other computers or devices have to your 
computer in a network that authenticates through a domain controller. These settings 

allow, by default, authenticated users of the domain to see and access your computer. 

Enable 

If this option is enabled, Windows Firewall is activated and working through the Avira 

product. 

Block all incoming connections 

If this option is enabled, Windows Firewall will reject all unsolicited attempts to connect 

to your computer, including incoming connections from allowed applications. 
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Notify me when a new app is blocked 

If this option is enabled, you will receive a notification every time that Windows Firewall 
blocks a new program or app. 

Disable (not recommended) 

If this option is enabled, Windows Firewall is deactivated. This option is not 
recommended, it puts your computer at risk. 

Note 
This option is only available if your computer is connected to a network with a 

domain controller. 

Application rules 

If you click the link under Windows Firewall > Application rules, you will be redirected to 

the menu Allowed apps and features of the Windows Firewall configuration. 

Advanced settings 

If you click the link under Windows Firewall > Advanced settings, you will be redirected 
to the menu Windows Firewall with Advanced Security of the Windows Firewall 

configuration. 

10.6 Web Protection 

The Web Protection section under Configuration > Internet Protection is responsible 

for the configuration of the Web Protection. 

10.6.1 Scan 

Web Protection protects you against viruses or malware that reach your computer from 
web pages that you load on your web browser from the Internet. The Scan options can be 

used to set the behavior of the Web Protection component. 

Scan 

Enable IPv6 support 

If this option is enabled, Internet Protocol version 6 is supported by the Web 
Protection. This option is not available for new or changed installations under Windows 

8. 

Drive-by protection 

Drive-by protection allows you to make settings to block I-Frames, also known as inline 
frames. I-Frames are HTML elements, i.e. elements of Internet pages that delimit an area 
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of a web page. I-Frames can be used to load and display different web content - usually 
other URLs - as independent documents in a sub-window of the browser. I-Frames are 
mostly used for banner advertising. In some cases, I-Frames are used to conceal 
malware. In these cases the area of the I-Frame is mostly invisible or almost invisible in 
the browser. The Block suspicious I-frames option allows you to check and block the 

loading of I-Frames. 

Block suspicious I-frames 

If this option is enabled, I-Frames on the web pages you request are scanned 
according to certain criteria. If there are suspect I-Frames on a requested web page, 

the I-Frame is blocked. An error message is displayed in the I-Frame window. 

Action on detection 

You can define the actions to be performed by Web Protection when a virus or unwanted 
program is detected. 

Interactive 

If this option is enabled, a dialog box appears when a virus or unwanted program is 
detected during an on-demand scan, in which you can choose what is to be done with 

the affected file. This option is enabled as the default setting. 

Show progress bar 

If this option is enabled, a desktop notification appears with a download progress bar if 
a download of website content exceeds a 20 second timeout. This desktop notification 
is designed in particular for downloading websites with larger data volumes: If you are 
surfing with Web Protection, website contents are not downloaded incrementally in the 
Internet browser, as they are scanned for viruses and malware before being displayed 

in the Internet browser. This option is disabled as the default setting. 

Click here for more information. 

Automatic 

If this option is enabled, no dialog box in case of a virus detection appears. Web 
Protection reacts according to the settings you predefine in this section as primary and 
secondary action. 

Primary action 

The primary action is the action performed when Web Protection finds a virus or an 

unwanted program. 

Deny access 

The website requested from the web server and/ or any data or files transferred are 
not sent to your web browser. An error message to notify you that access has been 
denied is displayed in the web browser. Web Protection logs the detection to the report 
file if the report function is activated. 
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Move to quarantine 

In the event of a virus or malware being detected, the website requested from the web 
server and/ or the transferred data and files are moved into quarantine. The affected 
file can be recovered from the quarantine manager if it has any informative value or - if 

necessary - sent to the Avira Malware Research Center. 

Ignore 

The website requested from the web server and/ or the data and files that were 
transferred are forwarded on by Web Protection to your web browser. Access to the 

file is permitted and the file is ignored. 

Warning 
The affected file remains active on your workstation! It may cause serious 

damage on your workstation! 

Blocked requests 

In Blocked requests you can specify the file types and MIME types (content types for the 
transferred data) to be blocked by Web Protection. Web Protection prevents the transfer of 

data from the Internet to your computer system. 

Web Protection blocks the following file types / MIME-Types 

All file types and MIME types (content types for the transferred data) in the list are blocked 
by Web Protection. 

Input box 

In this box, enter the names of the MIME types and file types you want Web Protection 
to block. For file types, enter the file extension, e.g. .htm. For MIME types, indicate the 
media type and, where applicable, sub-type. The two statements are separated from 
one another by a single slash, e.g. video/mpeg or audio/x-wav. 

Note 
Files which are already stored on your system as temporary Internet files and 
blocked by Web Protection can, however, be downloaded locally from the 
Internet by your computer's Internet browser. Temporary Internet files are files 
saved on your computer by the Internet browser so that websites can be 

accessed more quickly. 

  

Note 
The list of blocked file and MIME types is ignored if they are entered in the list of 
excluded file and MIME types under Web Protection > Scan > Exceptions. 
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Note 
No wildcards (* for any number of characters or ?  for a single character) can be 

used when entering file types and MIME types. 

MIME types: Examples for media types:  

 text = for text files 

 image = for graphics files 

 video = for video files 

 audio = for sound files 

 application = for files linked to a particular program 

Examples of excluded file and MIME types  

 application/octet-stream = application/octet-stream MIME type files 

(executable files *.bin, *.exe, *.com, *dll, *.class) are blocked by Web Protection. 

 application/olescript = application/olescript MIME type files (ActiveX script-

files *.axs) are blocked by Web Protection. 

 .exe = All files with the extension .exe (executable files) are blocked by Web 

Protection. 

 .msi = All files with the extension .msi (Windows Installer files) are blocked by Web 

Protection. 

Add 

The button allows you to copy MIME and file types from the input field into the display 

window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 

selected. 

Exceptions 

These options allow you to set exceptions based on MIME types (content types for the 
transferred data) and file types for URLs (Internet addresses) for scanning by Web 

Protection. The MIME types and URLs specified are ignored by Web Protection, i.e. that 
data is not scanned for viruses and malware when it is transferred to your computer 
system. 

MIME types skipped by Web Protection 

In this field you can select the MIME types (content types for the transferred data) to be 
ignored by Web Protection during scanning. 

File types/MIME types skipped by Web Protection (user-defined) 
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All MIME types (content types for the transferred data) in the list are ignored by Web 
Protection during scanning. 

Input box 

In this box you can input the name of the MIME types and file types to be ignored by 
Web Protection during scanning. For file types, enter the file extension, e.g.  .htm. For 
MIME types, indicate the media type and, where applicable, sub-type. The two 
statements are separated from one another by a single slash, e.g.  video/mpeg or 
audio/x-wav. 

Note 
No wildcards (* for any number of characters or ?  for a single character) can be 

used when entering file types and MIME types. 

Warning 
All file types and content types on the exclusion list are downloaded into the 
Internet browser without further scanning of the blocked requests (list of file and 
MIME types to be blocked in Web Protection > Scan > Blocked requests) or by 
Web Protection: For all entries on the exclusion list, the entries on the list of file 
and MIME types to be blocked are ignored. No scan for viruses and malware is 

performed. 

MIME types: Examples for media types:  

 text = for text files 

 image = for graphics files 

 video = for video files 

 audio = for sound files 

 application = for files linked to a particular program 

Examples of excluded file and MIME types: 

 audio/ = All audio media type files are excluded from Web Protection scans 

 video/quicktime = All Quicktime sub-type video files (*.qt, *.mov) are excluded 

from Web Protection scans 

 .pdf = All Adobe PDF files are excluded from Web Protection scans.  

Add 

The button allows you to copy MIME and file types from the input field into the display 

window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 

selected. 
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URLs skipped by Web Protection 

All URLs in this list are excluded from Web Protection scans. 

Input box 

In this box you can input URLs (Internet addresses) to be excluded from Web 

Protection scans, e.g. www.domainname.com. You can specify parts of the URL, 

using leading or following dots to indicate the domain level: .domainname.com for all 

pages and all subdomains of the domain. Indicate websites with any top-level domain 

(.com or .net) with a following dot: domainname.. If you indicate a string without a 

leading or concluding dot, the string is interpreted as a top-level domain, e.g. net for 

all NET domains (www.domain.net). 

Note 
You can also use the wildcard * for any number of characters when specifying 
URLs. You can also use leading or following dots in combination with wildcards 
to indicate the domain level: 
.domainname.* 

*.domainname.com 

.*name*.com (valid but not recommended) 

Specifications without dots, like *name*, are interpreted as part of a top-level 

domain and are not advisable. 

Warning 
All websites on the list of excluded URLs are downloaded into the Internet 
browser without further scanning by Web Protection: No scan for viruses and 
malware is performed. Only trusted URLs should therefore be excluded from 

Web Protection scans. 

Add 

The button allows you to copy the URL entered in the input field (Internet address) to 
the viewer window. 

Delete 

The button deletes a selected entry from the list. This button is inactive if no entry is 
selected. 

Examples: Skipped URLs 

 www.avira.com  -OR- www.avira.com/* 

= All URLs with the domain www.avira.com are excluded from Web Protection 

scans: www.avira.com/en/pages/index.php, www.avira.com/en/support/index.html, 
www.avira.com/en/download/index.html, etc. 

URLs with the domain www.avira.de are not excluded from Web Protection scans. 
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 avira.com  -OR- *.avira.com 

= All URLs with the second and top-level domain avira.com are excluded from 

Web Protection scans: The specification implies all existing subdomains for 

.avira.com: www.avira.com, forum.avira.com, etc. 

 avira. -OR- *.avira.* 

= All URLs with the second-level domain avira are excluded from Web Protection 

scans: The specification implies all existing top-level domains or subdomains for 

.avira: www.avira.com, www.avira.de, forum.avira.com, etc. 

 .*domain*.* 

All URLs containing a second-level domain with the string domain are excluded from 

Web Protection scans: www.domain.com, www.new-domain.de, www.sample-
domain1.de, ... 

 net -OR- *.net 

= All URLs with the top-level domain net are excluded from Web Protection scans: 

www.name1.net, www.name2.net, etc. 

Warning 
Enter the URLs you want to exclude from the Web Protection scan as precisely 
as possible. Avoid specifying an entire top-level domain or parts of a second-
level domain because there is a risk that Internet pages that distribute malware 
and undesirable programs will be excluded from the Web Protection scan 
through global specifications under exclusions. You are recommended to 
specify at least the complete second-level domain and the top-level domain: 
domainname.com 

Heuristic 

This configuration section contains the settings for the heuristic of the scan engine. 

Avira products contain very powerful heuristics that can proactively uncover unknown 
malware, i.e. before a special virus signature to combat the damaging element has been 
created and before a virus guard update has been sent. Virus detection involves an 
extensive analysis and investigation of the affected codes for functions typical of malware. 
If the code being scanned exhibits these characteristic features, it is reported as being 
suspicious. This does not necessarily mean that the code is in fact malware. False 
positives do sometimes occur. The decision on how to handle affected code is to be made 
by the user, e.g. based on his or her knowledge of whether the source of the code is 
trustworthy or not. 

Macrovirus heuristic 

Your Avira product contains a highly powerful macrovirus heuristic. If this option is 
enabled, all macros in the relevant document are deleted in the event of a repair, 
alternatively suspect documents are only reported, i.e. you receive an alert. This 

option is enabled as the default setting and is recommended. 

Advanced Heuristic Analysis and Detection (AHeAD) 
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Enable AHeAD 

Your Avira program contains a very powerful heuristic in the form of Avira AHeAD 
technology, which can also detect unknown (new) malware. If this option is enabled, 
you can define how "aggressive" this heuristic should be. This option is enabled as the 

default setting. 

Low detection level 

If this option is enabled, slightly less unknown malware is detected, the risk of false 
alerts is low in this case. 

Medium detection level 

This option combines a strong detection level with a low risk of false alerts. Medium is 
the default setting if you have selected the use of this heuristic. 

High detection level 

If this option is enabled, significantly more unknown malware is detected, but there are 
also likely to be false positives. 

10.6.2 Report 

The Web Protection includes an extensive logging function to provide the user or 

administrator with exact notes about the type and manner of a detection. 

Reporting 

This group allows for the content of the report file to be determined. 

Off 

If this option is enabled, then Web Protection does not create a log. 
It is recommended that you should turn off the logging function only in exceptional 
cases, such as if you are executing trials with multiple viruses or unwanted programs. 

Default 

If this option is enabled, Web Protection records important information (concerning 
detections, alerts and errors) in the report file, with less important information ignored 

for improved clarity. This option is enabled as the default setting. 

Extended 

If this option is enabled, Web Protection logs less important information to the report 

file as well. 

Complete 

If this option is enabled, Web Protection logs all available information in the report file, 

including file size, file type, date, etc. 

Limit report file 
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Limit size to n MB 

If this option is enabled, the report file can be limited to a certain size; possible values: 
Permitted values are between 1 and 100 MB. Around 50 kilobytes of extra space are 
allowed when limiting the size of the report file to minimize the use of system 
resources. If the size of the log file exceeds the indicated size by more than 50 
kilobytes, old entries are then deleted until the indicated size has been reduced by 

20%. 

Write configuration in report file 

If this option is enabled, the configuration of the on-access scan is recorded in the 

report file. 

Note 
If you have not specified any report file restriction, older entries are 
automatically deleted when the report file reaches 100 MB. Entries are deleted 

until the size of the report file reaches 80 MB. 

10.7 General 

10.7.1 Threat categories 

Selection of extended threat categories 

Your Avira product protects you against computer viruses. In addition, you can scan 
according to the following extended threat categories. 

 Adware 

 Adware/Spyware 

 Applications 

 Backdoor Clients 

 Dialer 

 Double Extension Files 

 Fraudulent software 

 Games 

 Jokes 

 Phishing 

 Programs that violate the private domain 

 Unusual runtime packers 

By clicking on the relevant box, the selected type is enabled (check mark set) or disabled 
(no check mark). 
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Select all 

If this option is enabled, all types are enabled. 

Default values 

This button restores the predefined default values. 

Note 
If a type is disabled, files recognized as being of the relevant program type are 
no longer indicated. No entry is made in the report file. 

10.7.2 Password 

You can protect your Avira product in different areas with a password. If a password has 
been issued, you will be asked for this password every time you want to open the 

protected area. 

Password 

Enter password 

Enter your required password here. For security reasons, the actual characters you 
type in this space are replaced by asterisks (*). The password can only have a 
maximum of 20 chars. Once the password has been issued, the program refuses 
access if an incorrect password is entered. An empty box means "No password". 

Confirmation 

Confirm the password entered above by entering again here. For security reasons, the 
actual characters you type in this space are replaced by asterisks (*). 

Note 

The password is case-sensitive! 

Areas protected by password 

Your Avira product can protect individual areas with a password. By clicking the relevant 
box, the password request can be disabled or re-enabled for individual areas as required. 
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Password-protected 

area 

Function 

Control Center  If this option is enabled, the pre-defined 
password is required to start the Control 
Center. 

Activate / 
deactivate Real-

Time Protection 

If this option is enabled, the pre-defined 
password is required to enable or disable Avira 

Real-Time Protection. 

Activate / 
deactivate Web 

Protection 

If this option is enabled, the pre-defined 
password is required to enable/disable Web 

Protection. 

Quarantine If this option is enabled, all areas of the 
quarantine manager protected by a password 
are enabled. By clicking on the relevant box, 
the password enquiry can be disabled or 
enabled again on request for individual areas. 

Restore 
affected 
objects 

If this option is enabled, the pre-defined 

password is required to restore an object. 

Rescan 
affected 

objects 

If this option is enabled, the pre-defined 
password is required to rescan an object. 

Affected 
object 

properties 

If this option is enabled, the pre-defined 
password is required to display the properties 

of an object. 

Delete 
affected 

objects 

If this option is enabled, the pre-defined 
password is required to delete an object. 
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Send email to 
Avira 

If this option is enabled, the pre-defined 
password is required to send an object to the 
Avira Malware Research Center for 

examination. 

Configuration If this option is enabled, configuration of the 
program is only possible after entering the pre-

defined password. 

Installation / 
uninstallation 

If this option is enabled, the pre-defined 
password is required for installation or 

uninstallation of the program. 

10.7.3 Security 

Autorun 

Block autorun function 

If this option is enabled, the execution of the Windows autorun function is blocked on 
all connected drives, including USB sticks, CD and DVD drives and network drives. 
With the Windows autorun function, files on data media or network drives are read 
immediately on loading or connection, and files can therefore be started and copied 
automatically. This functionality carries with it a high security risk, however, as 
malware and unwanted programs can be installed with the automatic start. The 
autorun function is especially critical for USB sticks as data on a stick can be changed 

at any time. 

Exclude CDs and DVDs 

When this option is enabled, the autorun function is permitted on CD and DVD drives. 

Warning 
Only disable the autorun function for CD and DVD drives if you are sure you are 

only using trusted data media. 

System protection 

Protect Windows hosts files from changes 

If this option is set to activated, the Windows hosts files are write-protected. 
Manipulation is no longer possible. For example, malware is not able to redirect you to 

undesired websites. This option is activated as the default setting. 

Product protection 
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Note 
The product protection options are not available if the Real-Time Protection has 

not been installed using the user-defined installation option. 

Protect processes from unwanted termination 

If this option is enabled, all processes of the program are protected against unwanted 
termination by viruses and malware or against 'uncontrolled' termination by a user, e.g. 

via Task-Manager. This option is enabled as the default setting. 

Advanced process protection 

If this option is enabled, all processes of the program are protected with advanced 
options against unwanted termination. Advanced process protection requires 
considerably more computer resources than simple process protection. The option is 
enabled as the default setting. To disable this option, you have to restart your 

computer. 

Note 
Process protection is not available for Windows XP 64 bit ! 

Warning 
If process protection is enabled, interaction problems can occur with other 

software products. Disable process protection in these cases. 

Protect files and registry entries from manipulation 

If this option is enabled, all registry entries of the program and all program files (binary 
and configuration files) are protected from manipulation. Protection against 
manipulation entails preventing write, delete and, in some cases, read access to the 
registry entries or program files by users or external programs. To enable this option, 
you have to restart your computer. 

Warning 
Please note that, if this option is disabled, the repair of computers infected with 

specific types of malware may fail. 

Note 
When this option is activated, changes can only be made to the configuration, 
including changes to scan or update requests, by means of the user interface. 
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Note 
Protection for files and registration entries is not available for Windows XP 64 

bit ! 

10.7.4 WMI 

Support for Windows Management Instrumentation 

Windows Management Instrumentation is a basic Windows management technology that 
uses script and programming languages to allow read and write access, both local and 
remote, to settings on Windows systems. Your Avira product supports WMI and provides 

data (status information, statistical data, reports, planned requests, etc.) as well as events 
via an interface. WMI gives you the option of downloading operating data from the 
program 

Enable WMI support 

When this option is enabled, you can download operating data from the program via 
WMI. 

10.7.5 Events 

Limit size of event database 

Limit size to max. n entries 

If this option is enabled, the maximum number of events listed in the event database 
can be limited to a certain size; possible values: 100 to 10000 entries. If the number of 

entered entries is exceeded, the oldest entries are deleted. 

Delete all events older than n day(s) 

If this option is enabled, events listed in the event database are deleted after a certain 
period of time; possible values: 1 to 90 days. This option is enabled as the default 
setting, with a value of 30 days. 

No limit 

When this option has been activated, the size of the event database is not limited. 
However, a maximum of 20,000 entries are displayed in the program interface under 

Events. 

10.7.6 Reports 

Limit reports 
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Limit number to max. n piece 

When this option is enabled, the maximum number of reports can be limited to a 
specific amount. Values between 1 and 300 are permissible. If the specified number is 

exceeded, then the oldest report at that time is deleted. 

Delete all reports older than n day(s) 

If this option is enabled, reports are automatically deleted after a specific number of 
days. Permissible values are: 1 to 90 days. This option is enabled as the default 

setting, with a value of 30 days. 

No limit 

If this option is enabled, the number of reports is not restricted. 

10.7.7 Directories 

Temporary path 

Use default system settings 

If this option is enabled, the settings of the system are used for handling temporary 

files. 

Note 
You can see where your system saves temporary files - for example with 
Windows XP - under: Start > Settings > Control Panel > System > Index 
card "Advanced" Button "Environment Variables". The temporary variables 

(TEMP, TMP) for the currently registered user and for system variables (TEMP, 

TMP) are shown here with their relevant values. 

Use following directory 

If this option is enabled, the path displayed in the input box is used. 

Input box 

In this input box, enter the path where the program will store its temporary files. 

 

The button opens a window in which you can select the required temporary path. 

Default 

The button restores the pre-defined directory for the temporary path. 
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10.7.8 Acoustic alerts 

When a virus or malware is detected by the System Scanner or Real-Time Protection, an 
acoustic alert is heard in interactive action mode. You can now choose to activate or 
deactivate the acoustic alert and select an alternative WAVE file for the alert. 

Note 
The action mode of the System Scanner is set in the configuration under 

System Scanner > Scan > Action on detection.  

No warning 

When this option is enabled, there is no acoustic alert when a virus is detected by the 

System Scanner or Real-Time Protection. 

Use PC speakers (only in interactive mode) 

If this option is enabled, there is an acoustic alert with the default signal when a virus 
is detected by the System Scanner or Real-Time Protection. The acoustic alert is 

sounded on the PC's internal speaker. 

Use the following WAVE file (only in interactive mode) 

If this option is enabled, there is an acoustic alert with the selected WAVE file when a 
virus is detected by the System Scanner or Real-Time Protection. The selected WAVE 
file is played over a connected external speaker. 

WAVE file 

In this input box you can enter the name and the associated path of an audio file of 
your choice. The program's default acoustic signal is entered as standard. 

 

The button opens a window in which you can select the required file with the aid of the 

file explorer. 

Test 

This button is used to test the selected WAVE file. 

10.7.9 Alerts 

Your Avira product generates so-called slide-ups, desktop notifications for specific events, 
which give information on successful or failed program sequences such as updates. Under 

Alerts you can enable or disable the notifications for specific events. 

With desktop notifications, you have the option of disabling the notification directly in the 
slide-up. You can reactivate the notification, in the Alerts configuration window. 

Update 
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Alert, if last update is older than n day(s) 

In this box, you can enter the maximum number of days allowed to have passed since 
the last update. If this number of days has passed, a red icon is displayed for the 

update status under Status in the Control Center. 

Show notice if the virus definition file is out of date 

If this option is enabled, you will obtain an alert if the virus definition file is not up-to-
date. With the help of the alert option, you can configure the temporal interval for an 

alert if the last update is older than n day(s). 

Warnings / Notes with the following situations 

Dial-up connection is used 

If this option is enabled, you will receive a desktop notification alert if a dialer creates a 
dial-up connection on your computer via the telephone or ISDN network. There is a 
danger that the connection may have been created by an unknown and unwanted 
dialer and that the connection may be chargeable (see Viruses and more > Threat 

categories: Dialer). 

Files have been successfully updated 

If this option is enabled, you will receive a desktop notification whenever an update 

has been successfully performed and files updated. 

Update failed 

If this option is enabled, you will receive a desktop notification whenever an update 
fails: No connection to the download server could be created or the update files could 

not be installed. 

No update necessary 

If this option is enabled, you will receive a desktop notification whenever an update is 

started but installation of the files is not necessary as your program is up to date. 
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11. Tray Icon 

The tray icon in the system tray of the taskbar displays the status of the Real-Time 

Protection service. 

Icon Description 

 

Avira Real-Time Protection is enabled 

 

Avira Real-Time Protection is disabled 

Entries in the context menu 

 Enable Real-Time Protection: Enables or disables the Avira Real-Time Protection. 

 Enable Web Protection: Enables or disables the Avira Web Protection. 

 Enable Windows Firewall: Enables or disables the Windows Firewall (this feature is 
available starting from Windows 8). 

 Start Avira Free Antivirus: Opens the Control Center. 

 Configure Avira Free Antivirus: Opens the Configuration. 

 My messages: Opens a slide-up with the current information about your Avira product. 

 Start update Starts an update. 

 Help: opens the Online Help. 

 Experts Market - Ask for help: opens the Experts Market - Ask for help website where 
you can ask for help or offer your help to other users.  

 About Avira Free Antivirus: Opens a dialog box with information on your Avira 
product: Product information, Version information, License information. 

 Avira on the Internet: Opens the Avira web portal on the Internet. The condition for this 
is that you have an active connection to the Internet. 

Note 
The User Account Control (UAC) will ask for your permission to enable or 
disable the Real-Time Protection and Web Protection services in operating 

systems as of Windows Vista. 
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12. In Product Messages 

12.1.1 Product Message Subscription Center 

You will reach the Product Message Subscription Center by clicking My communication 

settings in the context menu of the Avira Tray Icon or by clicking the symbol for 

Configuration in the slide-up of My messages. 

  You may influence the information flow by clicking the according ON/OFF button. 

  Click Update Profile to configure your personal messaging profile. 

  You receive the message that your profile was updated successfully. 

 Join us online by clicking on one of the links. 

12.1.2 Current Information 

The slide-up My messages is used as channel of communication. It provides you with the 
newest developments on Internet security, news on the Avira products (updates, upgrades 

and license notifications) and virus information. 

If there are no new messages, you receive the information No new messages available. 

Click OK to close the slide-up. 

If new messages are available you have the following options: 

  Click Remind me later, if you want to read the message to a later time. 

  Click + Read more, for reading all details of the message. 

  Depending on the kind of message you will be directed to our home page or a 
new window will expand to provide the information to you. 

  Click the little x symbol to close single messages. 

  Click the symbol for Configuration in the header of the slide-up to create your 
personal messaging profile. 
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13. FireWall 

Avira Free Antivirus allows you to manage the incoming and outgoing data traffic 

depending on computer settings: 

 Windows Firewall 

Starting from Windows 7, Avira Free Antivirus allows the Windows Firewall management 
through the Avira product. 

13.1 Windows Firewall 

Avira Free Antivirus gives you the option of managing directly the Windows Firewall via the 
Avira Control and Configuration Center. The following options are available for Windows 

Firewall: 

enabling Windows Firewall through the Control Center 

The FireWall option under Status > Internet Protection allows you to enable or 

disable the Windows Firewall by clicking the ON/OFF button. 

checking the status of the Windows Firewall through the Control Center 

You can check the status of the Windows Firewall under the section INTERNET 
PROTECTION > FireWall and restore the recommended settings by clicking the Fix 

problem button. 
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14. Updates 

14.1 Updates 

The effectiveness of anti-virus software depends on how up-to-date the program is, in 
particular the virus definition file and the scan engine. To carry out regular updates, the 
Updater component is integrated into your Avira product. The Updater ensures that your 
Avira product is always up-to-date and able to deal with the new viruses that appear every 

day. Updater updates the following components: 

 Virus definition file: 

 The virus definition file contains the virus patterns of the harmful programs which are 
used by your Avira product to scan for viruses and malware and repair infected 
objects. 

 Scan engine: 

 The scan engine contains the methods used by your Avira product to scan for viruses 
and malware. 

 Program files (product update): 

 Update packages for product updates make extra functions available to the individual 
program components. 

An update checks whether the virus definition file, the scan engine and the product are up-
to-date and if necessary, implements an update. After a product update, you may have to 
restart your computer system. If only the virus definition file and scan engine are updated, 
the computer does not have to be restarted. 

When a product update requires a reboot, you can decide whether to continue with the 
update or to be reminded again later about the update. If you continue with the product 

update immediately, you are still able to choose when the reboot should take place. 

If you want to be reminded about the update later on, the virus definition file and the scan 
engine will be updated anyway, but the product update will not be done. 

Note 

The product update will not be completed until a reboot has occurred. 

Note 
For security reasons, the Updater checks whether the Windows hosts file of 
your computer was altered, whether the Update URL, for example, was 
manipulated by malware and is diverting the Updater to unwanted download 
sites. If the Windows hosts file has been manipulated, this is shown in the 
Updater report file. 



 Updates 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 162 

An update is automatically performed in the following interval: 6 hours.  

In the Control Center under Scheduler, you can create additional update jobs that are 
performed by Updater at the specified intervals. You also have the option to start an 
update manually: 

 in the Control Center: in the Update menu and in the Status section 

 via the context menu of the tray icon 

Updates can be obtained from the Internet via Web server of the manufacturer. The 
existing network connection is the default connection to the download servers of Avira. 

You can change this default setting under Configuration > Update. 

14.2 Updater 

The Updater window opens at the start of an update. 

 

Note 
For update jobs created in Scheduler, you can define the display mode for the 
update window: You can select Hide, Minimize or Maximize. 

Note 
If you are using a program in fullscreen mode (e.g. games) and the updater's 
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display mode is set to maximized or minimized, the updater will switch to the 
desktop. To prevent this, start the updater with the display mode set to hide. In 

this mode you will no longer be notified about updates by the update window. 

Status: Shows the proceeding of the updater. 

Time elapsed: Time which has elapsed since starting the download. 

Time remaining: Time until download is finished. 

Download speed: Speed of download. 

Transmitted: Bytes already downloaded. 

Remaining: Bytes left to download. 

Buttons and links 

Button / link Description 

 

This page of the online help is opened via this button or link. 

Reduce The display window of the updater will appear in a reduced size. 

Enlarge The display window of the updater will be re-established to its original size. 

Abort The update procedure will be canceled. The updater will be closed. 

Close The update procedure is completed. The display window will be closed. 

Report The report file of the update is displayed. 
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15. FAQ, Tips 

This chapter contains important information on troubleshooting and further tips on using 

your Avira product. 

 see Chapter Help in case of a problem 

 see Chapter Shortcuts 

 see Chapter Windows Security Center  (Windows XP) or Windows Action Center (as of 
Windows 7)  

15.1 Help in case of a problem 

Here you will find information on causes and solutions of possible problems. 

 The error message Connection failed while downloading the file ... appears when 
attempting to start an update. 

 Viruses and malware cannot be moved or deleted. 

 The status of the tray icon is disabled. 

 The computer is extremely slow when I perform a data back-up. 

 My firewall reports Avira Real-Time Protection immediately after activation. 

 Webchat is not operational: Chat messages will not be displayed; data are being loaded in 
the browser 

The error message Connection failed while downloading the file ... appears when 
attempting to start an update. 

Reason: Your Internet connection is inactive. No connection to the web server on the 

Internet can therefore be established. 

  Test whether other Internet services such as WWW or email work. If not, re-establish 
the Internet connection. 

Reason: The proxy server cannot be reached. 

  Check whether the login for the proxy server has changed and adapt it to your 
configuration if necessary. 

Reason: The update.exe file is not fully approved by your personal firewall. 

  Ensure that the update.exe file is fully approved by your personal firewall. 

Otherwise: 

  Check your settings in the Configuration under PC Protection > Update. 
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Viruses and malware cannot be moved or deleted. 

Reason: The file was loaded by windows and is active. 

  Update your Avira product. 

  If you use the Windows XP operating system, deactivate System Restore. 

  Start the computer in Safe Mode. 

  Start the Configuration of your Avira product . 

  Select System Scanner > Scan > Files > All files and confirm the window with OK. 

  Start a scan of all local drives. 

  Start the computer in Normal Mode. 

  Carry out a scan in Normal Mode. 

  If no other viruses or malware have been found, activate System Restore if it is 
available and to be used. 

The status of the tray icon is disabled. 

Reason: Avira Real-Time Protection is disabled. 

  In the Control Center click Status and enable the Real-Time Protection in the PC 
Protection area . 

-OR- 

  Open the context menu with a right-click on the Tray Icon. Click Real-Time 
Protection enable. 

  

Reason: Avira Real-Time Protection is blocked by a firewall. 

  Define a general approval for Avira Real-Time Protection in the configuration of your 
firewall. Avira Real-Time Protection only works with the address 127.0.0.1 
(localhost). An Internet connection is not established.  

Otherwise: 

  Check the startup type of the Avira Real-Time Protection service. If necessary, 
enable the service: In the taskbar, select Start > Settings > Control Panel. Start the 
configuration panel Services with a double-click (under Windows XP the services 
applet is located in the sub-directory Administrative Tools). Find the entry Avira Real-

Time Protection. Automatic must be entered as the startup type and Started as 

the status. If necessary, start the service manually by selecting the relevant line and 
the button Start. If an error message appears, please check the event display. 
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The computer is extremely slow when I perform a data back-up. 

Reason: During the backup procedure, Avira Real-Time Protection scans all files being 

used by the backup procedure. 

  Select Real-Time Protection > Scan > Exceptions in the Configuration and enter 
the process names of the back-up software. 

My firewall reports Avira Real-Time Protection  

Reason: Communication with Avira Real-Time Protection occurs via the TCP/IP Internet 

protocol. A firewall monitors all connections via this protocol. 

  Define a general approval for Avira Real-Time Protection. Avira Real-Time Protection 
only works with the address 127.0.0.1 (localhost). An Internet connection is not 
established.  

Note 
We recommend regularly installing Microsoft updates to close any gaps in 

security. 

Webchat is not operational: Chat messages will not be displayed; data are being loaded in 
the browser. 

This phenomenon may occur during chats, which are based on the HTTP protocol with 

'transfer-encoding: chunked’. 

Reason: Web Protection checks the sent data completely for viruses and undesired 
programs first, before the data are loaded into the web browser. During a data transfer 
with ‘transfer-encoding: chunked’, Web Protection cannot determine the message length 

or the data volume. 

  Enter the configuration of the URL of the web chats as an exception (see 
Configuration: Web Protection > Scan > Exceptions). 

15.2 Shortcuts 

Keyboard commands - also called shortcuts - offer a fast possibility to navigate through the 

program, to retrieve individual modules and to start actions. 

Below we provide you with an overview of the available keyboard commands. Please find 
further indications regarding the functionality in the corresponding chapter of the help. 
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15.2.1 In dialog boxes 

Shortcut Description 

Ctrl + Tab 
Ctrl + Page down 

Navigation in the Control Center 
Go to next section. 

Ctrl + Shift + Tab 
Ctrl + Page up 

Navigation in the Control Center 
Go to previous section. 

 

Navigation in the configuration sections 
First, use the mouse to set the focus on a configuration section. 

  

Change between the options in a marked drop-down list or 
between several options in a group of options. 

Tab Change to the next option or options group. 

Shift + Tab Change to the previous option or options group. 

Space Activate or deactivate a check box, if the active option is a 
check box. 

Alt + underlined 
letter 

Select option or start command. 

Alt + ↓ 

F4 

Open selected drop-down list. 

Esc Close selected drop-down list. 

Cancel command and close dialog. 

Enter Start command for the active option or button. 
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15.2.2 In the help 

Shortcut Description 

Alt + Space Display system menu. 

Alt + Tab Shift between the help and the other opened windows. 

Alt + F4 Close help. 

Shift + F10 Display context menu of the help. 

Ctrl + Tab Go to next section in the navigation window. 

Ctrl + Shift + Tab Go to previous section in the navigation window. 

Page up Change to the subject, which is displayed above in the contents, in 
the index or in the list of the search results. 

Page down Change to the subject, which is displayed below the current subject 
in the contents, in the index or in the list of the search results. 

Page up 
Page down 

Browse through a subject. 

15.2.3 In the Control Center 

General 

Shortcut Description 

F1 Display help 

Alt + F4 Close Control Center 

F5 Refresh 

F8 Open configuration 
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F9 Start update 

Scan section 

Shortcut Description 

F3 Start scan with the selected profile 

F4 Create desktop link for the selected profile 

Quarantine section 

Shortcut Description 

F2 Rescan object 

F3 Restore object 

F4 Send object 

F6 Restore object to... 

Return Properties 

Ins Add file 

Del Delete object 

Scheduler section 

Shortcut Description 

F2 Edit job 

Return Properties 
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Ins Insert new job 

Del Delete job 

Reports section 

Shortcut Description 

F3 Display report file 

F4 Print report file 

Return Display report 

Del Delete report(s) 

Events section 

Shortcut Description 

F3 Export event(s) 

Return Show event 

Del Delete event(s) 

15.3 Windows Security Center 

- Windows XP Service Pack 3 - 

15.3.1 General 

The Windows Security Center checks the status of a computer for important security 

aspects. 

If a problem is detected with one of these important points (e.g. an outdated anti-virus 
program), the Security Center issues an alert and gives recommendations on how to 
protect your computer better. 
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15.3.2 The Windows Security Center and your Avira product 

Virus protection software / Protection against malicious software 

You may receive the following information from the Windows Security Center with regard 
to your virus protection: 

 Virus protection NOT FOUND 

 Virus protection OUT OF DATE 

 Virus protection ON 

 Virus protection OFF 

 Virus protection NOT MONITORED 

Virus protection NOT FOUND 

This information of the Windows Security Center appears when the Windows Security 

Center has not found any anti-virus software on your computer. 

 

Note 
Install your Avira product on your computer to protect it against viruses and 
other unwanted programs! 

Virus protection OUT OF DATE 

If you have already installed Windows XP Service Pack 3 and then install your Avira 
product or you install Windows XP Service Pack 3 on a system on which your Avira 
product has already been installed, you will receive the following message: 
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Note 
In order for the Windows Security Center to recognize your Avira product as up-
to-date, an update must be performed after installation. Update your system by 
carrying out an update. 

Virus protection ON 

After installing your Avira product and performing a subsequent update, you will receive 

the following message: 

 

Your Avira product is now up-to-date and the Avira Real-Time Protection is enabled. 

Virus protection OFF 

You receive the following message if you disable the Avira Real-Time Protection or stop 

the Real-Time Protection service. 

 

Note 
You can enable or disable Avira Real-Time Protection in the Status section of 
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the Control Center. You can also see that the Avira Real-Time Protection is 
enabled if the red umbrella in your taskbar is open. 

Virus protection NOT MONITORED 

If you receive the following message from the Windows Security Center, you have decided 

that you want to monitor your anti-virus software yourself. 

 

Note 
The Windows Security Center is supported by your Avira product. You can 

enable this option at any time via the Recommendations button. 

  

Note 
Even if you have installed Windows XP Service Pack 3, you still require a virus 
protection solution. Although Windows monitors your anti-virus software, it does 
not contain any anti-virus functions itself. Therefore you would not be protected 

against viruses and other malware without an additional anti-virus solution! 

15.4 Windows Action Center 

- Windows 7 and Windows 8 - 

15.4.1 General 

Note: 
Starting from Windows 7 the Windows Security Center has been renamed to 
Windows Action Center. Under this section you will find the status of all your 
security options. 

The Windows Action Center checks the status of a computer for important security 
aspects. You can access it directly by clicking the little flag in your taskbar or under 

Control Panel > Action Center. 
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If a problem is detected with one of these important points (e.g. an outdated anti-virus 
program), the Action Center issues an alert and gives recommendations on how to protect 
your computer better. This means, that if everything works correctly, you won't be bothered 
with messages. You still can have a look at the security status of your computer in the 
Windows Action Center, under the Security item. 
The Windows Action Center also gives you the option of managing the installed 
programs and to choose between them (e.g. View installed antispyware programs). 

You can even turn off the warning messages under Change Action Center settings (e.g. 
Turn off messages about spyware and related protection). 

15.4.2 The Windows Action Center and your Avira product 

 Windows Firewall is turned off or set up incorrectly  

Windows Firewall is turned off or set up incorrectly 

 

 Windows Firewall installed 

Starting from Windows 7, Avira Free Antivirus gives you the option of directly managing 
the Windows Firewall from the Avira Control and Configuration Center. 

Virus protection 

You may receive the following information from the Windows Action Center with regard to 
your virus protection: 

 Avira Desktop reports that it is up to date and virus scanning is on.  

 Avira Desktop reports that it is turned off. 

 Avira Desktop reports that it is out of date. 

 Windows did not find antivirus software on this computer. 

 Avira Desktop has expired. 

Avira Desktop reports that it is up to date and virus scanning is on 

After installation of your Avira product and a subsequent update, you will not receive any 
messages from the Windows Action Center. But if you go to  Action Center > Security 
you can see: Avira Desktop reports that it is up to date and virus scanning is on. This 

means that your Avira product is now up-to-date and the Avira Real-Time Protection is 

enabled. 
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Avira Desktop reports that it is turned off 

You receive the following message if you disable the Avira Real-Time Protection or stop 

the Real-Time Protection service.  

 

Note 
You can enable or disable Avira Real-Time Protection in the Status section of 

the Avira Control Center. You can also notice that the Avira Real-Time 
Protection is enabled by the opened red umbrella in your taskbar. It is also 
possible to activate the Avira product by clicking the Turn on now button on the 

Windows Action Center message. You will receive a notification asking your 
permission to run Avira. Click on Yes, I trust the publisher and want to run this 
program and Real-Time Protection will be enabled again. 

Avira Desktop reports that it is out of date 

If you just installed Avira or if for some reason the virus definition file, the scan engine or 
the program files of your Avira product have not been updated automatically (e.g. if you 
have made an upgrade from an older Windows operating system, on which your Avira 

product is already installed), you will receive the following message: 

 

Note 
In order for the Windows Action Center to recognize your Avira product as up-
to-date, an update must be performed after installation. Update your Avira 

Product by carrying out an update. 

Windows did not find antivirus software on this computer 

This information of the Windows Action Center appears, when the Windows Action Center 
has not found any anti-virus software on your computer.  



 FAQ, Tips 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 176 

 

Note 
Please note that this option will not appear in Windows 8, as Windows Defender 

is now also the pre-set virus protection function. 

Note 
Install your Avira product on your computer to protect it against viruses and 

other unwanted programs! 

Avira Desktop has expired 

This information of the Windows Action Center appears when the license of your Avira 
product has expired. 
If you click on the button Renew subscription, you will be redirected to the website of 
Avira, where you can buy a new license. 

 

Note 

Please note that this option is only available for Windows 8. 

Spyware and unwanted software protection 

You may receive the following information from the Windows Action Center with regard to 

your spyware protection: 

 Avira Desktop reports that it is turned on. 

 Windows Defender and Avira Desktop both report that they are turned off. 

 Avira Desktop reports that it is out of date. 

 Windows Defender is out of date. 

 Windows Defender is turned off. 
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Avira Desktop reports that it is turned on 

After the installation of your Avira product and a subsequent update, you will not receive 
any messages from the Windows Action Center. But if you go to Action Center > 
Security, you can see: Avira Desktop reports that it is turned on. This means that your 

Avira product is now up-to-date and the Avira Real-Time Protection is enabled. 

Windows Defender and Avira Desktop both report that they are turned off 

You receive the following message if you disable the Avira Real-Time Protection or stop 

the Real-Time Protection service.  

 

Note 
You can enable or disable Avira Real-Time Protection in the Status section of 
the Avira Control Center. You can also notice that the Avira Real-Time 
Protection is enabled by the opened red umbrella in your taskbar. It is also 
possible to activate the Avira product by clicking the Turn on now button on the 

Windows Action Center message. You will receive a notification asking your 
permission to run Avira. Click on Yes, I trust the publisher and want to run this 

program and Real-Time Protection will be enabled again. 

Avira Desktop reports that it is out of date 

If you just installed Avira or if for some reason the virus definition file, the scan engine or 
the program files of your Avira product have not been updated automatically (e.g. if you 
have made an upgrade from an older Windows operating system, on which your Avira 

product is already installed), you will receive the following message: 

 

Note 
In order for the Windows Action Center to recognize your Avira product as up-
to-date, an update must be performed after installation. Update your Avira 
Product by carrying out an update. 
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Windows Defender is out of date 

You may receive the following message if Windows Defender is activated. If you have 
already installed the Avira product, this message should not appear. Please check if the 
installation went OK. 

 

Note 
Windows Defender is the pre-set spyware and virus protection solution from 

Windows. 

Windows Defender is turned off 

This information of the Windows Action Center appears when the Windows Action Center 
has not found any other anti-virus software on your computer than the one that the 
operating system integrates by default: Windows Defender. If you have had some anti-
virus software installed on your computer before, this application has been disabled. If you 
have already installed the Avira product, this message should not appear: Avira should be 

automatically detected. Please check if the installation went OK. 

 
  



 Viruses and more 

Avira Free Antivirus - User Manual (Status: 16 Dec. 2013) 179 

16. Viruses and more 

Avira Free Antivirus not only detects viruses and malware, it can also protect you from 
other threats. In this chapter you can find an overview of different kinds of malware and 
other threats describing their background, behavior and the unpleasant surprises they 
have in store for you. 

Related topics: 

 Threat categories 

 Viruses and other malware 

16.1 Threat categories 

Adware 

Adware is software that presents banner ads or in pop-up windows through a bar that 
appears on a computer screen. These advertisements usually cannot be removed and are 
consequently always visible. The connection data allow many conclusions on the usage 

behavior and are problematic in terms of data security. 

Your Avira product detects Adware. If the Adware option is enabled with a check mark in 
the configuration under Threat categories, you receive a corresponding alert if your Avira 

product detects adware. 

Adware/Spyware 

Software that displays advertising or software that sends the user’s personal data to a third 
party, often without their knowledge or consent, and for this reason may be unwanted. 

Your Avira product recognizes "Adware/Spyware". If the option Adware/Spyware is 
enabled with a check mark in the configuration under Threat categories, you receive a 

corresponding alert if your Avira product detects adware or spyware. 

Application 

The term APPL, respectively application, refers to an application which may involve a risk 

when used or is of dubious origin. 

Your Avira product recognizes "Application (APPL)". If the option Application is enabled 
with a check mark in the configuration under Threat categories, you receive a 
corresponding alert if your Avira product detects such behavior. 
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Backdoor Clients 

In order to steal data or manipulate computers, a backdoor server program is smuggled in 
unknown to the user. This program can be controlled by a third party using backdoor 

control software (client) via the Internet or a network. 

Your Avira product recognizes "Backdoor control software". If the Backdoor control 
software option is enabled with a check mark in the configuration under Threat categories, 
you receive a corresponding alert if your Avira product detects such software. 

Dialer 

Certain services available in the Internet have to be paid for. They are invoiced in 
Germany via dialers with 0190/0900 numbers (or via 09x0 numbers in Austria and 
Switzerland; in Germany, the number is set to change to 09x0 in the medium term). Once 
installed on the computer, these programs guarantee a connection via a suitable premium 

rate number whose scale of charges can vary widely. 

The marketing of online content via your telephone bill is legal and can be of advantage to 
the user. Genuine dialers leave no room for doubt that they are used deliberately and 
intentionally by the user. They are only installed on the user’s computer subject to the 
user’s consent, which must be given via a completely unambiguous and clearly visible 
labeling or request. The dial-up process of genuine dialers is clearly displayed. Moreover, 

genuine dialers tell you the incurred costs exactly and unmistakably. 

Unfortunately there are also dialers which install themselves on computers unnoticed, by 
dubious means or even with deceptive intent. For example they replace the Internet user’s 
default data communication link to the ISP (Internet Service Provider) and dial a cost-
incurring and often horrendously expensive 0190/0900 number every time a connection is 
made. The affected user will probably not notice until his next phone bill that an unwanted 
0190/0900 dialer program on his computer has dialed a premium rate number with every 

connection, resulting in dramatically increased costs. 

We recommend that you ask your telephone provider to block this number range directly 
for immediate protection against undesired dialers (0190/0900 dialers). 

Your Avira product can detect the familiar dialers by default. 

If the option Dialers is enabled with a check mark in the configuration under Threat 
categories, you receive a corresponding alert if a dialer is detected. You can now simply 
delete the potentially unwanted 0190/0900 dialer. However, if it is a wanted dial-up 
program, you can declare it an exceptional file and this file is then no longer scanned in 
future. 

Double Extension Files 

Executable files that hide their real file extension in a suspicious way. This camouflage 

method is often used by malware. 
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Your Avira product recognizes "Double Extension Files". If the option Double Extension 
files is enabled with a check mark in the configuration under Threat categories, you 

receive a corresponding alert if your Avira product detects such files. 

Fraudulent software 

Also known as "scareware" or "rogueware", it is a fraudulent software that pretends that 
your computer is infected by viruses or malware. This software looks deceptively similar to 
professional antivirus software but is meant to raise uncertainty or to scare the user. Its 
purpose is to make the victims feel threatened of imminent (unreal) danger and to make 
them pay to eliminate it. There are also cases when the victims are lead to believe they 
were attacked and they are instructed to carry out an action, which in reality is the real 

attack. 

Your Avira product detects scareware. If the option Fraudulent software is enabled with a 
check mark in the configuration Threat categories, you receive a corresponding alert if 

your Avira product detects such files. 

Games 

There is a place for computer games - but it is not necessarily at work (except perhaps in 
the lunch hour). Nevertheless, with the wealth of games downloadable from the Internet, a 
fair bit of mine sweeping and Patience playing goes on among company employees and 
civil servants. You can download a whole array of games via the Internet. Email games 
have also become more popular: numerous variants are circulating, ranging from simple 
chess to "fleet exercises" (including torpedo combats): The corresponding moves are sent 

to partners via email programs, who answer them. 

Studies have shown that the number of working hours devoted to computer games has 
long reached economically significant proportions. It is therefore not surprising that more 
and more companies are considering ways of banning computer games from workplace 

computers. 

Your Avira product recognizes computer games. If the Games option is enabled with a 
check mark in the configuration under Threat categories, you receive a corresponding alert 
if your Avira product detects a game. The game is now over in the truest sense of the 
word, because you can simply delete it. 

Jokes 

Jokes are merely intended to give someone a fright or provide general amusement without 
causing harm or reproducing. When a joke program is loaded, the computer will usually 
start at some point to play a tune or display something unusual on the screen. Examples of 
jokes are the washing machine in the disk drive (DRAIN.COM) or the screen eater 

(BUGSRES.COM). 

But beware! All symptoms of joke programs may also originate from a virus or Trojan. At 
the very least users will get quite a shock or be thrown into such a panic that they 

themselves may cause real damage. 
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Thanks to the extension of its scanning and identification routines, your Avira product is 
able to detect joke programs and eliminate them as unwanted programs if required. If the 
option Jokes is enabled with a check mark in the configuration under Threat categories, a 

corresponding alert is issued if a joke program is detected. 

Phishing 

Phishing, also known as "brand spoofing" is a clever form of data theft aimed at customers 
or potential customers of Internet service providers, banks, online banking services, 
registration authorities. 
When submitting your email address on the Internet, filling in online forms, accessing 
newsgroups or websites, your data can be stolen by "Internet crawling spiders" and then 

used without your permission to commit fraud or other crimes. 

Your Avira product recognizes "Phishing". If the option Phishing is enabled with a check 
mark in the configuration under Threat categories, you receive a corresponding alert if 

your Avira product detects such behavior. 

Programs that violate the private domain 

Software that may be able to compromise the security of your system, initiate unwanted 
program activities, damage your privacy or spy on your user behavior and could therefore 

be unwanted. 

Your Avira product detects "Security Privacy Risk" software. If the option Programs that 
violate the private domain is enabled with a check mark in the configuration under 
Threat categories, you receive a corresponding alert if your Avira product detects such 
software. 

Unusual Runtime Packers 

Files that have been compressed with an unusual runtime packer and that can therefore 

be classified as potentially suspicious. 

Your Avira product recognizes "Unusual runtime packers". If the option Unusual runtime 
packers is enabled with a check mark in the configuration under Threat categories, you 

receive a corresponding alert if your Avira product detects such packers. 

16.2 Viruses and other malware 

Adware 

Adware is software that presents banner ads or in pop-up windows through a bar that 
appears on a computer screen. These advertisements usually cannot be removed and are 
consequently always visible. The connection data allow many conclusions on the usage 
behavior and are problematic in terms of data security. 
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Backdoors 

A backdoor can gain access to a computer by bypassing the computer access security 

mechanisms. 

A program that is being executed in the background generally enables the attacker almost 
unlimited rights. User's personal data can be spied with the backdoor's help. But are 
mainly used to install further computer viruses or worms on the relevant system. 

Boot viruses 

The boot or master boot sector of hard disks is mainly infected by boot sector viruses. 
They overwrite important information necessary for the system execution. One of the 

awkward consequences: the computer system cannot be loaded any more… 

Bot-Net 

A bot-net is defined as a remote network of PCs (on the Internet) that is composed of bots 
that communicate with each other. A bot-net can comprise a collection of cracked 
machines running programs (usually referred to as worms, Trojans) under a common 
command and control infrastructure. Bot-nets serve various purposes, including denial-of-
service attacks etc., usually without the affected PC user's knowledge. The main potential 
of bot-nets is that the networks can achieve grow to thousands of computers and their total 

bandwidth exceeds most conventional Internet accesses. 

Exploit 

An exploit (security gap) is a computer program or script that takes advantage of a bug, 
glitch or vulnerability leading to privilege escalation or denial of service on a computer 
system. One form of exploitation for example is an attack from the Internet with the help of 

manipulated data packages. Programs can be infiltrated in order to obtain higher access. 

Fraudulent software 

Also known as "scareware" or "rogueware", it is a fraudulent software that pretends that 
your computer is infected by viruses or malware. This software looks deceptively similar to 

professional Antivirus software but is meant to raise uncertainty or to scare the user. Its 
purpose is to make the victims feel threatened of imminent (unreal) danger and to make 
them pay to eliminate it. There are also cases when the victims are lead to believe they 
were attacked and they are instructed to carry out an action, which in reality is the real 

attack. 
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Hoaxes 

For several years, Internet and other network users have received alerts about viruses that 
are purportedly spread via email. These alerts are spread via email with the request that 
they should be sent to the highest possible number of colleagues and to other users, in 

order to warn everyone against the "danger". 

Honeypot 

A honeypot is a service (program or server) installed in a network. Its function is to monitor 
a network and log attacks. This service is unknown to the legitimate user - because of this 
reason he is never addressed. If an attacker examines a network for the weak points and 

uses the services which are offered by a honeypot, it is logged and an alert is triggered. 

Macro viruses 

Macro viruses are small programs that are written in the macro language of an application 
(e.g. WordBasic under WinWord 6.0) and that can normally only spread within documents 
of this application. Because of this, they are also called document viruses. In order to be 
active, they need that the corresponding applications are activated and that one of the 
infected macros has been executed. Unlike "normal" viruses, macro viruses consequently 
do not attack executable files but they do attack the documents of the corresponding host 

application. 

Pharming 

Pharming is a manipulation of the host file of web browsers to divert enquiries to spoofed 
websites. This is a further development of classic phishing. Pharming fraudsters operate 
their own large server farms on which fake websites are stored. Pharming has established 
itself as an umbrella term for various types of DNS attacks. In the case of a manipulation 
of the host file, a specific manipulation of a system is carried out with the aid of a Trojan or 
virus. The result is that the system can now only access fake websites, even if the correct 

web address is entered. 

Phishing 

Phishing means angling for personal details of the Internet user. Phishers generally send 
their victims apparently official letters such as emails that are intended to induce them to 
reveal confidential information to the culprits in good faith, in particular user names and 
passwords or PINs and TANs of online banking accounts. With the stolen access details, 
the phishers can assume the identities of the victims and carry out transactions in their 
name. What is clear is that: banks and insurance companies never ask for credit card 

numbers, PINs, TANs or other access details by email, SMS or telephone. 
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Polymorph viruses 

Polymorph viruses are the real masters of disguise. They change their own programming 

codes - and are therefore very hard to detect. 

Program viruses 

A computer virus is a program that is capable of attaching itself to other programs after 
being executed and cause an infection. Viruses multiply themselves unlike logic bombs 
and Trojans. In contrast to a worm, a virus always requires a program as host, where the 
virus deposits its virulent code. The program execution of the host itself is not changed as 
a rule. 

Rootkits 

A rootkit is a collection of software tools that are installed after a computer system has 
been infiltrated to conceal logins of the infiltrator, hide processes and record data - 
generally speaking: to make themselves invisible. They attempt to update already installed 
spy programs and reinstall deleted spyware. 

Script viruses and worms 

Such viruses are extremely easy to program and they can spread - if the required 
technology is on hand - within a few hours via email round the globe. 

Script viruses and worms use one of the script languages, such as Javascript, VBScript 
etc., to insert themselves in other, new scripts or to spread themselves by calling operating 
system functions. This frequently happens via email or through the exchange of files 
(documents). 

A worm is a program that multiplies itself but that does not infect the host. Worms cannot 
consequently form part of other program sequences. Worms are often the only possibility 

to infiltrate any kind of damaging programs on systems with restrictive security measures. 

Spyware 

Spyware are so called spy programs that intercept or take partial control of a computer's 
operation without the user's informed consent. Spyware is designed to exploit infected 
computers for commercial gain. 

Trojan horses (short Trojans) 

Trojans are pretty common nowadays. Trojans include programs that pretend to have a 
particular function, but that show their real image after execution and carry out a different 
function that, in most cases, is destructive. Trojan horses cannot multiply themselves, 
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which differentiates them from viruses and worms. Most of them have an interesting name 
(SEX.EXE or STARTME.EXE) with the intention to induce the user to start the Trojan. 
Immediately after execution they become active and can, for example, format the hard 
disk. A dropper is a special form of Trojan that 'drops' viruses, i.e. embeds viruses on the 
computer system. 

Zombie 

A zombie PC is a computer that is infected with malware programs and that enables 
hackers to abuse computers via remote control for criminal purposes. On command, the 
affected PC starts denial-of-service (DoS) attacks, for example, or sends spam and 
phishing emails. 
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17. Info and Service 

This chapter contains information on how to contact us. 

 see Chapter Contact address 

 see Chapter Technical support 

 see Chapter Suspicious files 

 see Chapter Reporting false positives 

17.1 Contact address 

If you have any questions or requests concerning the Avira product range, we will be 
pleased to help you. For our contact addresses, please refer to the Control Center under 

Help > About Avira Free Antivirus. 

17.2 Technical support 

Avira support provides reliable assistance in answering your questions or solving a 
technical problem. 

All necessary information on our comprehensive support service can be obtained from our 
website: 

 http://www.avira.com/en/support 

So that we can provide you with fast, reliable help, you should have the following 
information ready: 

 Version information. You can find this information in the program interface under the 
menu item Help > About Avira Free Antivirus > Version information. See Version 
information. 

 Operating system version and any Service Packs installed. 

 Installed software packages, e.g. anti-virus software of other vendors. 

 Exact messages of the program or of the report file. 

17.3 Suspicious files 

Suspect files or viruses that may not yet be detected or removed by our products can be 

sent to us. We provide you with several ways of doing this. 

http://www.avira.com/en/support
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 Identify the file in the quarantine manager of the Control Center and select the item 
Send file via the context menu or the corresponding button. 

 Send the required file packed (WinZIP, PKZip, Arj, etc.) in the attachment of an email to 
the following address: 
virus@avira.com 
As some email gateways work with anti-virus software, you should also provide the 
file(s) with a password (please remember to tell us the password). 

17.4 Reporting false positives 

If you believe that your Avira product is reporting a detection in a file that is most likely 
"clean", send the relevant file packed (WinZIP, PKZip, Arj, etc.) as an email attachment to 

the following address: 

virus@avira.com 

As some email gateways work with anti-virus software, you should also provide the file(s) 
with a password (please remember to tell us the password). 

 

mailto:virus@avira.com
mailto:virus@avira.com
mailto:virus@avira.com
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